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Electrical equipment should be installed, operated, serviced, and maintained only by 

qualified personnel.  No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material. 

 



 

 
 2007 Schneider Electric, All Rights Reserved  Doc:  3070IB0701 Page 2 

WAGES SMS Add-on Reports & GFX Objects 
Instruction Bulletin 
 

About this Manual 
 

This manual is the instruction bulletin for the WAGES SMS Add-on Reports & 
GFX Objects.  Its sole purpose is describe the functionality and detail features 
of WAGES SMS Add-on Reports & GFX Objects offered by POWERLOGIC.  
Besides providing a description about SMS reports and Historical GFX 
Objects, this document also identifies the web navigation page enhancement 
and other miscellaneous utilities associated with displaying real-time and 
historical data from an SMS system. 
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Chapter 1 — Introduction 
 

The WAGES SMS Add-on is a collection of reports, GFX objects, and export 
utilities that provides users critical information about the historical record of 
resource usage and its cost.  The Add-on software enhances SMS and the 
Information Manager’s ability to provide such information.  The following 
briefly lists the reports, GFX objects, and export utilities available in a WAGES 
SMS Add-on CD. 

• Historical GFX Object - Statistical (Resource) Usage 

• Historical GFX Object – (Resource) Demand & Usage 

• Historical GFX Object - Coincidental Demand 

• Alarm Summary GFX Object & Enhancement 

• (Resource) Demand & Usage Reports 

• Range Comparison Reports (of Two Resources) 

• Enhanced Cost Summary Report (of Resource Usage) 

• Utilities to Export SMS History Data to Microsoft Excel File 

• Navigational Web Page 

Important:  do not simultaneously perform on-board logging and PC 
logging for WAGES device data.  It is recommended that the user 
perform on-board logging only for WAGES device data.  Simultaneous 
logging results in inaccurate readings in the reports, described in this 
document. 

 

Upon delivery and receipt, the WAGES Add-on software has the necessary 
software, and instruction bulletins to set up WAGES Add-on SMS.  The user 
may make an inventory of what they receive upon delivery and verify that the 
content is what they ordered.  If there are any discrepancies in box contents, 
the user should immediately contact their POWERLOGIC sales representative 
to resolve any discrepancies. 

 
The table below identifies the shipping contents. 
 

Table 1C. Shipping Contents 
 

SMS Add On, Reports & GFX Objects Compact Disc (CD) (Part 
#  WAGESADDON) 

 

 

WHAT IS WAGES ADD-ON? 

SHIPPING CONTENTS 
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Chapter 2 — Safety Precautions 
 

 DANGER 
 

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC 
FLASH 

� Apply appropriate personal protective equipment (PPE) and follow safe 
electrical work practices. See NFPA 70E. 

� Only qualified workers should install and wire this unit.  
� Turn off all power supplying this unit and the equipment in which it is 

installed before working on it.  
� Always use a properly rated voltage sensing device to confirm that all power 

is off.  
� After removing input power, wait a minimum of 30 seconds to allow energy 

to discharge.  
 

Failure to observe these instructions will result in death 
or serious injury. 
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Chapter 3 — Installation 
 

The WAGES Meter Add-on Reports & GFX Objects Compact Disc (CD) contains 
the WAGES Meter Add-on Reports & GFX Objects.  Upon insertion of the 
installation CD into the PC drive, follow instructions provided in dialog boxes.  
Execute installation of each product one at a time. 
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Chapter 4 — WAGES Add-on GFX Diagram Object: Statistical Diagram Object 
 

This chapter gives a step-by-step description of how to create and view a 
Statistical Diagram Object contained within a GFX Diagram.  This object is a 
WAGES Add-on Historical GFX Object.  Just as the name of the diagram object 
implies, the Statistical Diagram Object displays statistical information about an 
input channel data value over a period of time.  The input channel data value 
must have a logging template associated with it.  The data value must be 
actively logged in the WAGES device. 

The calculation of the statistical information is a function derived from a 
predefined range of time and a selected object type.  The object type specifies if 
the value is to be some statistical calculation made from a series of logged data 
values over a predefined range of time.  The object type may be an average, a 
minimum value, a maximum value, a sum (or summation), a count, or a standard 
deviation. 

 

The following procedures described how to create and view a Statistical Diagram 
Object. 

 

Note:  the SMS client must be opened and in the edit mode before proceeding to 
step 1. 

 

1. Click on the menu item “File>New>Diagram”.  This action activates and 
displays a dialog box querying the user whether or not to select a 
background image for the window.  The query dialog box is illustrated 
below.  Selecting “Yes” activates and displays a dialog box allowing the user 
to select a background image. 

Note:  at this point, the user may click the “Yes” button to use a background 
image for the diagram and then proceed to the next step in this procedure upon 
completion of this task.  Or the user may click on the “No” button to directly 
continue to the next step in the procedure.  The next step in this procedure is 
when the user completes selection of a background or does not opt to create a 
background image for the diagram. 

 

Figure 4A.  Dialog Box Querying User for Background Image for 
Diagram 

 

After selecting a background image or opting not to do so, a newly created GFX 
diagram appears as illustrated on the next page. 

INTRODUCTION 

CREATING A NEW DIAGRAM WITH A 
DIAGRAM OBJECT 
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Figure 4B.  Newly Created GFX Display 

 

2. Right-click to activate and display the “GFX Options” dialog box.  The dialog 
box has tabs, allowing the user to modify various features relating to the 
diagram. 

Note: at this point, the user may click the “Cancel” button to escape from the 
“GFX Options” dialog box or click on the different tabs and apply the features 
described below.  Then next step in this procedure involves creating the 
Statistical Diagram Object. 

The “Diagram Background Color” tab modifies the background color of the 
diagram.  The figure on the next page illustrates this dialog box. 

The “Grid Settings” tab defines whether or not a grid is present in the diagram 
and allows for a “snap-into-place” feature for the placement and movement of 
diagram objects.  The figure on the next page illustrates the dialog box. 

The “Drawing Size” tab defines the size of the diagram object.  The figure, on the 
second page from this page, illustrates the dialog box. 
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Figure 4C.  GFX Options Dialog Box – Diagram Background Color 
Tab 

 

Figure 4D.  GFX Options Dialog Box – Grid Settings Tab 
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Figure 4E.  GFX Options Dialog Box – Drawing Size 
 

 

3. Pressing the “Insert” key on the keyboard or clicking the “Edit>Insert GFX 
Object…” menu item activates and displays “Insert GFX Object” dialog box, 
as illustrated in the figure below. 

 

Figure 4F.  Insert GFX Object Dialog Box 
 

 

4. Select “OLE Control Selection…” in the menu box of the “Insert GFX 
Object” dialog box and press the “OK” button.  This action activates and displays 
the “OLE Control Selection” diagram box as illustrated in the figure on the next 
page. 
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Figure 4G.  OLE Control Selection 
 

 

5. Scroll down the choices of items in the menu box of the “OLE Control 
Selection” dialog box of the “OLE Control Selection” dialog box until 
reaching the “PL_GFX_HVB_Stats.Stat_Control” item as illustrated in the 
figure below.  Click on this item and press the “OK” button. 

 

Figure 4H.  OLE Control Selection – PL GFX HVB Control Options 
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This action causes the “OLE Control Selection” dialog box to disappear, re-
activating the GFX dialog window and invoking the appearance of a “cross-hair” 
cursor. 

6. Select an area of the diagram that is to be the upper-left hand corner of the 
diagram object.  Pressing continuously down on the left mouse button, move in a 
right-downward (right-to-bottom), diagonal direction and release the mouse 
button at the area of the diagram that is to be the lower-right hand corner of the 
diagram object.  This action creates the new diagram object.  An example 
diagram, as illustrated in the figure below, indicates how the newly created 
diagram object would appear. 

 

Figure 4I.  Newly Created GFX Diagram Object 
 

 

7. Double-click the newly created diagram object.  This action displays and 
activates the “PL GFX HVB Statistical Status Control Properties” dialog box.  
The figure on the next page illustrates the initial view of the dialog box.  The 
table on the next page identifies the tabs associated with the dialog box and 
briefly describes the function of each tab. 

 

 

 

PL GFX HVB STATISTICAL STATUS 
CONTROL PROPERTIES DIALOG 
BOX 
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Table 4A. Tabs on the “PL GFX HVB Statistical Control Properties” 
Dialog Box 

 

 

Tab Description 

  

General This tab allows the user to do the following. 

• To define the title of the diagram object, 

• To select the object type 

• To select the alignment of how to display 
the data contents in the diagram object 

• To define what types of information that 
the diagram object is to display. 

Device/Topic This tab allows the user to select an input 
channel data value, predefined in a data-
logging template, from an SMS History SQL 
Database. 

Date Range This tab allows the user to define the range of 
time to extract the recorded data from the SMS 
History SQL Database to calculate the statistic 
specified by the object type. 

Color This tab allows the user to define the 
foreground and background color of the 
diagram object. 

Font This tab allows the user to define the font of 
the diagram object along with its style and 
size. 

Picture This tab allows the user to attach a picture to 
the background of the diagram object. 

 

Figure 4J.  PL GFX HVB Statistical Status Control Properties Dialog 
Box – General Tab 
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Note: at this point of the procedure, the focus is to define the layout of the data 
displayed in the diagram object, to define the input channel device, and to define 
the range of time to abstract data from the data log.  Therefore, the areas of 
focus are primarily on entering and selecting data in the “General” tab, the 
“Device/Topic” tab, and the “Date Range” tab.  The user is encouraged to select 
the other tabs and experiment with and learn from the use of the other tabs.  The 
next series of steps only focus on the “General” tab, the “Device/Topic” tab, and 
the “Date Range” tab. 

 

8. Click on the “General” tab in the “GFX HVB Statistical Status Control 
Properties” dialog box.  This action displays and activates the “General Tab” 
as illustrated in the figure on the previous page. 

9. Enter the title of the diagram object in the “Title” text edit box within the 
“General” tab of the “GFX HVB Statistical Status Control Properties” dialog 
box. 

10. Select the object type (or statistical calculation) in the “Select Object Type” 
menu box within the “General” tab of the “GFX HVB Statistical Status 
Control Properties” dialog box.  The table below identifies the available 
object types (or statistical calculations) to choose. 

 

Table 4C. Available Object Types (or Statistical Calculations) 
 

 

• Average 

• Minimum (Min) 

• Maximum (Max) 

• Sum 

• Count 

• Standard Deviation 

 

11. Select one of the “Alignment” radio buttons, “Left”, “Center”, or “Right”, in 
the “General” tab of the “GFX HVB Statistical Status Control Properties” dialog 
box to define the alignment of the data in the diagram object. 

12. Check the appropriate check boxes to display whatever information is useful 
and beneficial.  The table, on the next page, identifies the different types of 
information accessible to the diagram object for display. 

 

 

 

 

GENERAL TAB 
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Table 4D. Types of Information Accessible to the Diagram Object 
for Display 

 

 

• Date (Option Only for “Minimum” & “Maximum” Object Type) 

• Period Name 

• Start/End Date 

• Refresh Time 

• Device & Quantity Name 

 

13. (Optional) Check or uncheck the check box entitled “Autogrow to Fit”.  
Checking this check box in the “General” tab of the “GFX HVB Statistical Status 
Control Properties” dialog box enables the diagram object to automatically grow 
or shrink in size.  This feature ensures that the data content is fully visible in the 
diagram object and not truncated - or that there is no excess of blank areas in 
the diagram object visible to the user. 

14. (Optional) Check or uncheck the check box entitled “Refresh on Demand”.  
Checking this check box allows the user access to an “R” button in the upper left 
corner of the diagram box.  Pressing the “R” button refreshes the data contents 
of the diagram object, showing what the results of the statistical calculation 
would be at that moment in time.  (This capability is not available for GFX Web.) 

15. Click on the “Device/Topic” tab.  This action displays and activates the 
“Device/Topic” tab as illustrated in the figure below. 

 

Figure 4K.  PL GFX HVB Statistical Status Control Properties Dialog 
Box – Device/Topic Tab 

 

 

DEVICE/TOPIC TAB 
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16. Select the SMS History SQL Database in the “History DSN” menu box within 
the “Device/Topic” tab of the “GFX HVB Statistical Status Control Properties” 
dialog box.  This action invokes a “Devices” item to appear in the tree control box 
in the lower left part of the “Device/Topic” tab. 

17. Click on the “+” adjacent to the “Device” item in the tree control in the lower 
left part of the “Device/Topic” tab.  This action expands the tree and reveals 
a list of one or more SMS groups.  Click on the “+” adjacent to the item in 
the tree listing the facility that holds one or more WAGES devices.  This 
action expands the tree and reveals a list of one or more meter and monitor 
devices.  Click on the item in the tree listing the device having the input 
channel data value to be displayed in the diagram object.  This action 
invokes the display of a “+” adjacent to the “Topics” item located in the tree 
control in the lower right part of the “Device/Topic” tab. 

18. Click on the “+” adjacent to the “Topics” item in the tree control in the lower 
right part of the “Device/Topic” tab.  This action expands the tree, revealing one 
or more input channel data values.  Click on the data value (or topic) to display in 
the diagram object. 

19. Click the “Apply” button in the “Device/Topic” tab in the “GFX HVB 
Statistical Status Control Properties” dialog box. 

20. Click the “Date Range” tab in the “GFX HVB Statistical Status Control 
Properties” dialog box.  This action displays and activates the “Date Range” tab, 
as illustrated in the figure below. 

 

Figure 4L.  PL GFX HVB Statistical Status Control Properties Dialog 
Box – Date Range Tab 

 

 

DATE RANGE TAB 
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21. Select a date range (or time range) from the items listed in “Select Date 
Range” menu box in the “Date Range” tab of the “GFX HVB Statistical 
Status Control Properties” dialog box.  The table, given below, provides a 
list of options available to the user. 

 

Table 4D. List of Date Ranges 
 

 

• Last Month 

• This Month to Date 

• Last 30 Days 

• Last Week 

• This Week to Date 

• Last 7 Days Today 

• Today 

• Custom 

 

All of the items in the menu box, except “Custom”, define the range of time to 
exstract data from a specified input channel (or topic). 

22. (Optional) Click “Custom…” in the “Date Range” tab within the “GFX HVB 
Statistical Status Control Properties” dialog box to define a customized date 
range.  This action activates the custom display selection boxes and text 
edit boxes as illustrated in the figure below.  The user has the option to 
select and modify the fields to define the custom time range.  Clicking the 
“Load Predefined” incorporates the custom time range.  Refer to Appendix 
B to define a custom date and time range. 

The “Allow To Change Period in Run Time” checkbox, if checked, permits a user 
to temporarily set a different time period for the GFX block.  When the GFX 
diagram is closed and re-opened, it reverts back to the original range. 

 

Figure 4M.  PL GFX HVB Statistical Status Control Properties 
Dialog Box – Color Tab 
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The user may select other tabs to modify other features relating to the diagram 
object.  The figures, below and on the next page, illustrate the “Color”, “Font”, 
and “Picture” tabs.  The “Color” tab allows a user to change the background or 
foreground color of the diagram object.  The “Font” tab provides the user with the 
ability to modify the type, style, and size of a font, relating to character strings in 
the diagram object.  The “Picture” tab allows the user to attach a graphic image 
as a background image for the diagram object. 

 

Figure 4N.  PL GFX HVB Statistical Status Control Properties Dialog 
Box – Color Tab 

 

Figure 4O.  PL GFX HVB Statistical Status Control Properties Dialog 
Box – Font Tab 

OTHER TABS 
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Figure 4P.  PL GFX HVB Statistical Status Control Properties Dialog 
Box – Picture Tab 
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To edit a diagram object, the SMS client must be in the edit-mode.  Clicking the 
“View” menu indicates whether the diagram is in edit-mode or run-mode.  If the 
diagram is in edit-mode, then the “View>Edit Mode” menu item is gray and the 
“View>Run Mode” menu item is dark.  If the diagram is in run-mode, then the 
tint of the item entries in the “View” menu are vice versa.  Clicking the dark menu 
item disables the current mode and enables the other mode. 

If the diagram is in the run mode, and the diagram object has a refresh button in 
the upper-left hand corner, represented by the letter “R”, then the user has the 
option to press it.  Pressing the button accesses the data values from the on-
board data log, calculates the statistic, and displays it in the diagram object.  The 
figures, below and on the next page, illustrate a GFX diagram object in the edit 
mode and in the run mode. 

It is important to note the “R” button is only visible and functional if the user 
chooses this functionality during the creation of the GFX diagram object.  If the 
“refresh-on-demand” functionality is not chosen, then the diagram object does 
not have the button and the diagram is only produced for a single sample of data 
when the diagram is first opened. 

 

Figure 4R.  GFX Diagram Object in Edit Mode 

EDIT MODE (EDITING DIAGRAM 
OBJECT) VERSUS RUN MODE 
(ACTIVELY DISPLAYING DATA) 
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Figure 4Q.  GFX Diagram Object in Run Mode 
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Chapter 5 — WAGES Add-on GFX Diagram Object: Demand/Usage Diagram Object 
 

This chapter gives a step-by-step description of how to create and view a 
Demand/Usage Diagram Object contained within a GFX Diagram.  This object is 
a WAGES Add-on Historical GFX Object.  Just as the name of the diagram 
object implies, the Demand/Usage Diagram Object displays information relating 
to resource demand and usage from an input channel data value over a period 
of time.  The input channel data value must have a logging template associated 
with it.  The data value must be actively logged in the WAGES device. 

Peak demand is the highest demand average recorded in a specific demand-
interval within a given span of time.  Demand interval is the amount of time 
required to calculate the demand average.  An example of peak demand is the 
highest 15-minute average reading of kW, known as Demand Real Power 
(kWD), recorded for electrical energy over a given span of time. 

Usage is difference between the amount of cumulative flow at the beginning of a 
specified time span and the amount of cumulative flow at the end of the same 
span.  The amount of water used in a month is a good example of usage. 

The following procedures described how to create and view a Demand/Usage 
Diagram Object. 

 

1. Click on the menu item “File>New>Diagram”.  This action activates and 
displays a dialog box querying the user whether or not to select a 
background image for the window.  The query dialog box is illustrated 
below.  Selecting “Yes” activates and displays a dialog box allowing the user 
to select a background image. 

Note:  at this point, the user may click the “Yes” button to use a background 
image for the diagram and then proceed to the next step in this procedure upon 
completion of this task.  Or the user may click on the “No” button to directly 
continue to the next step in the procedure.  The next step in this procedure is 
when the user completes selection of a background or does not opt to create a 
background image for the diagram. 

 

Figure 5A.  Dialog Box Querying User for Background Image for 
Diagram 

 

After selecting a background image or opting not to do so, a newly created GFX 
diagram appears as illustrated on the next page. 

 

INTRODUCTION 

CREATING A NEW DIAGRAM WITH A 
DIAGRAM OBJECT 
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Figure 5B.  Newly Created GFX Display 

 

2. Right-click to activate and display the “GFX Options” dialog box.  The dialog 
box has tabs, allowing the user to modify various features relating to the 
diagram. 

Note: at this point, the user may click the “Cancel” button to escape from the 
“GFX Options” dialog box or click on the different tabs and apply the features 
described below.  Then next step in this procedure involves creating the 
Statistical Diagram Object. 

The “Diagram Background Color” tab modifies the background color of the 
diagram.  The figure on the next page illustrates this dialog box. 

The “Grid Settings” tab defines whether or not a grid is present in the diagram 
and allows for a “snap-into-place” feature for the placement and movement of 
diagram objects.  The figure on the next page illustrates the dialog box. 
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Figure 5C.  GFX Options Dialog Box – Diagram Background Color 
Tab 

 

Figure 5D.  GFX Options Dialog Box – Grid Settings Tab 
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The “Drawing Size” tab defines the size of the diagram object.  The figure, 
below, illustrates the dialog box. 

 

Figure 5E.  GFX Options Dialog Box – Drawing Size 

 

3. Pressing the “Insert” key on the keyboard or clicking the “Edit>Insert GFX 
Object…” menu item activates and displays “Insert GFX Object” dialog box, 
as illustrated in the figure below. 

 

Figure 5F.  Insert GFX Object Dialog Box 

 

4. Select “OLE Control Selection…” in the menu box of the “Insert GFX 
Object” dialog box and press the “OK” button.  This action activates and displays 
the “OLE Control Selection” diagram box as illustrated in the figure on the next 
page. 
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Figure 5G.  OLE Control Selection 
 

 

5.  Scroll down the choices of items in the menu box of the “OLE Control 
Selection” dialog box of the “OLE Control Selection” dialog box until reaching the 
“PL_GFX_HVB_DemandUsage.DemUs_Control” item as illustrated in the figure 
below.  Click on this item and press the “OK” button. 

 

Figure 5H.  OLE Control Selection – PL GFX HVB Control Options 
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This action causes the “OLE Control Selection” dialog box to disappear, re-
activating the GFX dialog window and invoking the appearance of a “cross-hair” 
cursor. 

6. Select an area of the diagram that is to be the upper-left hand corner of the 
diagram object.  Pressing continuously down on the left mouse button, move in a 
right-downward (right-to-bottom), diagonal direction and release the mouse 
button at the area of the diagram that is to be the lower-right hand corner of the 
diagram object.  This action creates the newly created diagram object.  An 
example diagram, as illustrated in the figure below, indicates how the newly 
created diagram object would appear. 

 

Figure 5I.  Newly Created GFX Diagram Object 
 

 

7. Double-click the newly created diagram object.  This action displays and 
activates the “PL GFX HVB Demand/Usage Control Properties” dialog box.  
The figure on the next page illustrates the initial view of the dialog box.  The 
table on the next page identifies the tabs associated with the dialog box and 
briefly describes the function of each tab. 

 

 

 

PL GFX HVB DEMAND/USAGE 
CONTROL PROPERTIES DIALOG 
BOX 
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Table 5A. Tabs on the “PL GFX HVB Demand/Usage Control 
Properties” Dialog Box 

 

 

Tab Description 

  

General This tab allows the user to do the following. 

• To define the title of the diagram object, 

• To select the object type 

• To select the alignment of how to display 
the data contents in the diagram object 

• To define what types of information that 
the diagram object is to display. 

Device/Topic This tab allows the user to select an input 
channel data value, predefined in a data-
logging template, from an SMS History SQL 
Database. 

Date Range This tab allows the user to define the range of 
time to extract the recorded data from the SMS 
History SQL Database to calculate the statistic 
specified by the object type. 

Color This tab allows the user to define the 
foreground and background color of the 
diagram object. 

Font This tab allows the user to define the font of 
the diagram object along with its style and 
size. 

Picture This tab allows the user to attach a picture to 
the background of the diagram object. 

 

Figure 5J.  PL GFX HVB Demand/Usage Control Properties Dialog 
Box – General Tab 
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Note: at this point of the procedure, the focus is to define the layout of the data 
displayed in the diagram object, to define the input channel device, and to define 
the range of time to abstract data from the data log.  Therefore, the areas of 
focus are primarily on entering and selecting data in the “General” tab, the 
“Device/Topic” tab, and the “Date Range” tab.  The user is encouraged to select 
the other tabs and experiment with and learn from the use of the other tabs.  The 
next series of steps only focus on the “General” tab, the “Device/Topic” tab, and 
the “Date Range” tab. 

 

8. Click on the “General” tab in the “GFX HVB Demand/Usage Control 
Properties” dialog box.  This action displays and activates the “General Tab” 
as illustrated in the figure on the previous page. 

9. Enter the title of the diagram object in the “Title” text edit box within the 
“General” tab of the “GFX HVB Demand/Usage Control Properties” dialog 
box. 

10. Select the object type (or statistical calculation) in the “Select Object Type” 
menu box within the “General” tab of the “GFX HVB Demand/Usage Control 
Properties” dialog box.  The table below identifies the available object types 
(or statistical calculations) to choose. 

 

Table 5C. Available Object Types (or Statistical Calculations) 
 

 

• Usage 

• Peak Demand 

 

11. Select one of the “Alignment” radio buttons, “Left”, “Center”, or “Right”, in 
the “General” tab of the “GFX HVB Demand/Usage Control Properties” dialog 
box to define the alignment of the data in the diagram object. 

12. Check the appropriate check boxes to display whatever information is useful 
and beneficial.  The table, on the next page, identifies the different types of 
information accessible to the diagram object for display. 

 

 

 

 

GENERAL TAB 
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Table 5D. Types of Information Accessible to the Diagram Object 
for Display 

 

 

• Title 

• Date (Option Only for “Demand” Object Type) 

• Period Name 

• Start/End Date 

• Refresh Time 

• Device & Quantity Name 

 

13. (Optional) Check or uncheck the check box entitled “Autogrow to Fit”.  
Checking this check box in the “General” tab of the “GFX HVB Demand/Usage 
Control Properties” dialog box enables the diagram object to automatically grow 
or shrink in size.  This feature ensures that the data content is fully visible in the 
diagram object and not truncated - or that there is no excess of blank areas in 
the diagram object visible to the user. 

14. (Optional) Check or uncheck the check box entitled “Refresh on Demand”.  
Checking this check box allows the user access to an “R” button in the upper left 
corner of the diagram box.  Pressing the “R” button refreshes the data contents 
of the diagram object, showing what the results of the statistical calculation 
would be at that moment in time.  (This is capability is not available for GFX 
Web.) 

 

15. Click on the “Device/Topic” tab.  This action displays and activates the 
“Device/Topic” tab as illustrated in the figure below. 

 

Figure 5K.  PL GFX HVB Demand/Usage Control Properties Dialog 
Box – Device/Topic Tab 

 

DEVICE/TOPIC TAB 
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16. Select the SMS History SQL Database in the “History DSN” menu box within 
the “Device/Topic” tab of the “GFX HVB Demand/Usage Control Properties” 
dialog box.  This action invokes a “Devices” item to appear in the tree 
control box in the lower left part of the “Device/Topic” tab. 

17. Click on the “+” adjacent to the “Device” item in the tree control in the lower 
left part of the “Device/Topic” tab.  This action expands the tree and reveals 
a list of one or more SMS device groups.  Click on the “+” adjacent to the 
item in the tree listing the facility that holds one or more WAGES devices.  
This action expands the tree and reveals a list of one or more meter and 
monitor devices.  Click on the item in the tree listing the device having the 
input channel data value to be displayed in the diagram object.  This action 
invokes the display of a “+” adjacent to the “Topics” item located in the tree 
control in the lower right part of the “Device/Topic” tab. 

18. Click on the “+” adjacent to the “Topics” item in the tree control in the lower 
right part of the “Device/Topic” tab.  This action expands the tree, revealing one 
or more input channel data values.  Click on the data value (or topic) to display in 
the diagram object. 

19. Click the “Apply” button in the “Device/Topic” tab in the “GFX HVB 
Demand/Usage Control Properties” dialog box. 

20. Click the “Date Range” tab in the “GFX HVB Demand/Usage Control 
Properties” dialog box.  This action displays and activates the “Date Range” tab, 
as illustrated in the figure below. 

 

Figure 5L.  PL GFX HVB Demand/Usage Control Properties Dialog 
Box – Date Range Tab 

 

 

DATE RANGE TAB 
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21. Select a date range (or time range) from the items listed in “Select Date 
Range” menu box in the “Date Range” tab of the “GFX HVB Demand/Usage 
Control Properties” dialog box.  The table, given below, provides a list of 
options available to the user. 

 

Table 5D. List of Date Ranges 
 

 

• Last Month 

• This Month to Date 

• Last 30 Days 

• Last Week 

• This Week to Date 

• Last 7 Days Today 

• Today 

• Custom 

 

All of the items in the menu box, except “Custom”, define the range of time to 
extract data from a specified input channel (or topic). 

22. (Optional) Click “Custom…” in the “Date Range” tab within the “GFX HVB 
Demand/Usage Control Properties” dialog box to define a customized date 
range.  This action activates the custom display selection boxes and text 
edit boxes as illustrated in the figure on the previous page.  The user has 
the option to select and modify the fields to define the custom time range.  
Clicking the “Load Predefined” incorporates the custom time range.  Refer 
to Appendix B to define a custom date and time range. 

The “Allow To Change Period in Run Time” checkbox, if checked, permits a user 
to temporarily set a different time period for the GFX block.  When the GFX 
diagram is closed and re-opened, it reverts back to the original range. 
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The user may select other tabs to modify other features relating to the diagram 
object.  The figures, below and on the next page, illustrate the “Color”, “Font”, 
and “Picture” tabs.  The “Color” tab allows a user to change the background or 
foreground color of the diagram object.  The “Font” tab provides the user with the 
ability to modify the type, style, and size of a font, relating to character strings in 
the diagram object.  The “Picture” tab allows the user to attach a graphic image 
as a background image for the diagram object. 

 

Figure 5N.  PL GFX HVB Demand/Usage Control Properties Dialog 
Box – Color Tab 

 

Figure 5O.  PL GFX HVB Demand/Usage Control Properties Dialog 
Box – Font Tab 

OTHER TABS 
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Figure 5P.  PL GFX HVB Demand/Usage Control Properties Dialog 
Box – Picture Tab 
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To edit a diagram object, the SMS client must be in the edit-mode.  Clicking the 
“View” menu indicates whether the diagram is in edit-mode or run-mode.  If the 
diagram is in edit-mode, then the “View>Edit Mode” menu item is gray and the 
“View>Run Mode” menu item is dark.  If the diagram is in run-mode, then the 
tint of the item entries in the “View” menu are vice versa.  Clicking the dark menu 
item disables the current mode and enables the other mode. 

If the diagram is in the run mode, and the diagram object has a refresh button in 
the upper-left hand corner, represented by the letter “R”, then the user has the 
option to press it.  Pressing the button accesses the data values from the on-
board data log, calculates the statistic, and displays it in the diagram object.  The 
figures, below and on the next page, illustrate a GFX diagram object in the edit 
mode and in the run mode. 

It is important to note the “R” button is only visible and functional if the user 
chooses this functionality during the creation of the GFX diagram object.  If the 
“refresh-on-demand” functionality is not chosen, then the diagram object does 
not have the button and the diagram is only produced for a single sample of data 
when the diagram is first opened. 

 

Figure 5R.  GFX Diagram Object in Edit Mode 

EDIT MODE (EDITING DIAGRAM 
OBJECT) VERSUS RUN MODE 
(ACTIVELY DISPLAYING DATA) 
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 Figure 5Q.  GFX Diagram Object in Run Mode 
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Chapter 6 — WAGES Add-on GFX Diagram Object: Coincident Demand Diagram Object 
 

This chapter gives a step-by-step description of how to create and view a 
Coincidental Demand Diagram Object contained within a GFX Diagram.  This 
object is a WAGES Add-on Historical GFX Object.  The Coincidental Diagram 
Object displays the peak demand for a main device and the demand average for 
a feeder device.  The date and time recorded for the demand average of the 
feeder device is the same time as the peak demand for the main device. 

The following procedures described how to create and view a Demand/Usage 
Diagram Object. 

 

1.  Click on the menu item “File>New>Diagram”.  This action activates and 
displays a dialog box querying the user whether or not to select a background 
image for the window.  The query dialog box is illustrated below.  Selecting “Yes” 
activates and displays a dialog box allowing the user to select a background 
image. 

Note:  at this point, the user may click the “Yes” button to use a background 
image for the diagram and then proceed to the next step in this procedure upon 
completion of this task.  Or the user may click on the “No” button to directly 
continue to the next step in the procedure.  The next step in this procedure is 
when the user completes selection of a background or does not opt to create a 
background image for the diagram. 

 

Figure 6A.  Dialog Box Querying User for Background Image for 
Diagram 

 

After selecting a background image or opting not to do so, a newly created GFX 
diagram appears as illustrated on the next page. 

 

INTRODUCTION 

CREATING A NEW DIAGRAM WITH A 
DIAGRAM OBJECT 
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Figure 6B.  Newly Created GFX Display 

 

2. Right-click to activate and display the “GFX Options” dialog box.  The dialog 
box has tabs, allowing the user to modify various features relating to the 
diagram. 

Note: at this point, the user may click the “Cancel” button to escape from the 
“GFX Options” dialog box or click on the different tabs and apply the features 
described below.  Then next step in this procedure involves creating the 
Statistical Diagram Object. 

The “Diagram Background Color” tab modifies the background color of the 
diagram.  The figure on the next page illustrates this dialog box. 

The “Grid Settings” tab defines whether or not a grid is present in the diagram 
and allows for a “snap-into-place” feature for the placement and movement of 
diagram objects.  The figure on the next page illustrates the dialog box. 

The “Drawing Size” tab defines the size of the diagram object.  The figure, on the 
second page from this page, illustrates the dialog box. 
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Figure 6C.  GFX Options Dialog Box – Diagram Background Color 
Tab 

 

Figure 6D.  GFX Options Dialog Box – Grid Settings Tab 
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Figure 6E.  GFX Options Dialog Box – Drawing Size 
 

 

3. Pressing the “Insert” key on the keyboard or clicking the “Edit>Insert GFX 
Object…” menu item activates and displays “Insert GFX Object” dialog box, 
as illustrated in the figure below. 

 

Figure 6F.  Insert GFX Object Dialog Box 
 

 

4. Select “OLE Control Selection…” in the menu box of the “Insert GFX 
Object” dialog box and press the “OK” button.  This action activates and displays 
the “OLE Control Selection” diagram box as illustrated in the figure on the next 
page. 
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Figure 6G.  OLE Control Selection 
 

 

5.     Scroll down the choices of items in the menu box of the “OLE Control 
Selection” dialog box of the “OLE Control Selection” dialog box until reaching the 
“PL_GFX_HVB_Coincident.Conic_Control” item as illustrated in the figure below.  
Click on this item and press the “OK” button. 

 

Figure 6H.  OLE Control Selection – PL GFX HVB Control Options 
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This action causes the “PL GFX HVB Control Options” dialog box to disappear, 
re-activating the GFX dialog window and invoking the appearance of a “cross-
hair” cursor. 

6. Select an area of the diagram that is to be the upper-left hand corner of the 
diagram object.  Pressing continuously down on the left mouse button, move in a 
right-downward (right-to-bottom), diagonal direction and release the mouse 
button at the area of the diagram that is to be the lower-right hand corner of the 
diagram object.  This action creates the newly created diagram object.  An 
example diagram, as illustrated in the figure below, indicates what the newly 
created diagram object would appear. 

 

Figure 6I.  Newly Created GFX Diagram Object 
 

 

7. Double-click the newly created diagram object.  This action displays and 
activates the “PL GFX HVB Coincident Control Properties” dialog box.  The 
figure on the next page illustrates the initial view of the dialog box.  The table 
on the next page identifies the tabs associated with the dialog box and 
briefly describes the function of each tab. 

 

 

 

PL GFX HVB COINCIDENT CONTROL 
PROPERTIES DIALOG BOX 
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Table 6A. Tabs on the “PL GFX HVB Coincident Control Properties” 
Dialog Box 
 

 

Tab Description 

  

General This tab allows the user to do the following. 

• To define the title of the diagram object, 

• To select the object type 

• To select the alignment of how to display 
the data contents in the diagram object 

• To define what types of information that 
the diagram object is to display. 

Device/Topic 
Main 

This tab allows the user to select a “main” 
input channel data value, predefined in a data-
logging template, from an SMS History SQL 
Database. 

Device/Topic 
Coincident 

This tab allows the user to select a “coincident” 
input channel data value, predefined in a data-
logging template, from an SMS History SQL 
Database. 

Date Range This tab allows the user to define the range of 
time to extract the recorded data from the SMS 
History SQL Database to calculate the statistic 
specified by the object type. 

Color This tab allows the user to define the 
foreground and background color of the 
diagram object. 

Font This tab allows the user to define the font of 
the diagram object along with its style and 
size. 

Picture This tab allows the user to attach a picture to 
the background of the diagram object. 

 

Figure 6J.  PL GFX HVB Coincident Control Properties Dialog Box – 
General Tab 
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Note: at this point of the procedure, the focus is to define the layout of the data 
displayed in the diagram object, to define the input channel device, and to define 
the range of time to abstract data from the data log.  Therefore, the areas of 
focus are primarily on entering and selecting data in the “General” tab, the 
“Device/Topic” tab, and the “Date Range” tab.  The user is encouraged to select 
the other tabs and experiment with and learn from the use of the other tabs.  The 
next series of steps only focus on the “General” tab, the “Device/Topic” tab, and 
the “Date Range” tab. 

 

8. Click on the “General” tab in the “GFX HVB Coincident Control Properties” 
dialog box.  This action displays and activates the “General Tab” as 
illustrated in the figure on the previous page. 

9. Enter the title of the diagram object in the “Title” text edit box within the 
“General” tab of the “GFX HVB Coincident Control Properties” dialog box. 

10. Select the object type (or statistical calculation) in the “Select Object Type” 
menu box within the “General” tab of the “GFX HVB Coincident Control 
Properties” dialog box.  The table below identifies the available object types 
(or statistical calculations) to choose. 

11. Select one of the “Alignment” radio buttons, “Left”, “Center”, or “Right”, in 
the “General” tab of the “GFX HVB Coincident Control Properties” dialog box to 
define the alignment of the data in the diagram object. 

12. Check the appropriate check boxes to display whatever information is useful 
and beneficial.  The table, on the next page, identifies the different types of 
information accessible to the diagram object for display. 

 

Table 6D. Types of Information Accessible to the Diagram Object 
for Display 

 

 

• Title 

• Date 

• Period Name 

• Start/End Date 

• Refresh Time 

• Device & Quantity Name 

 

 

 

 

GENERAL TAB 
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13 (Optional) Check or uncheck the check box entitled “Autogrow to Fit”.  
Checking this check box in the “General” tab of the “GFX HVB Coincident 
Control Properties” dialog box enables the diagram object to automatically grow 
or shrink in size.  This feature ensures that the data content is fully visible in the 
diagram object and not truncated - or that there is no excess of blank areas in 
the diagram object visible to the user. 

14 (Optional) Check or uncheck the check box entitled “Refresh on Demand”.  
Checking this check box allows the user access to an “R” button in the upper left 
corner of the diagram box.  Pressing the “R” button refreshes the data contents 
of the diagram object, showing what the results of the statistical calculation 
would be at that moment in time.  (This capability is not available for GFX Web.) 

15. Click on the “Device/Topic Main” tab or the “Device/Topic Coincident” 
tab. 

Urgent:  it is important that the user implements steps 12 through 16 for both 
“Device/Topic Main” and “Device/Topic Coincident”. 

This action displays and activates the “Device/Topic” tab as illustrated in the 
figure below. 

 

Figure 6K.  PL GFX HVB Coincident Control Properties Dialog Box 
– Device/Topic Tab 

 

 

DEVICE/TOPIC TAB MAIN & 
DEVICE/TOPIC CONCIDENT 
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16. Select the SMS History SQL Database in the “History DSN” menu box within 
the “Device/Topic” tab of the “GFX HVB Coincident Control Properties” 
dialog box.  This action invokes a “Devices” item to appear in the tree 
control box in the lower left part of the “Device/Topic” tab. 

17. Click on the “+” adjacent to the “Device” item in the tree control in the lower 
left part of the “Device/Topic” tab.  This action expands the tree and reveals 
a list of one or more SMS device groups.  Click on the “+” adjacent to the 
item in the tree listing the facility that holds one or more WAGES devices.  
This action expands the tree and reveals a list of one or more meter and 
monitor devices.  Click on the item in the tree listing the device having the 
input channel data value to be displayed in the diagram object.  This action 
invokes the display of a “+” adjacent to the “Topics” item located in the tree 
control in the lower right part of the “Device/Topic” tab. 

18. Click on the “+” adjacent to the “Topics” item in the tree control in the lower 
right part of the “Device/Topic” tab.  This action expands the tree, revealing one 
or more input channel data values.  Click on the data value (or topic) to display in 
the diagram object. 

19. Click the “Apply” button in the “Device/Topic” tab in the “GFX HVB 
Coincident Control Properties” dialog box. 

20. Click the “Date Range” tab in the “GFX HVB Coincident Control Properties” 
dialog box.  This action displays and activates the “Date Range” tab, as 
illustrated in the figure below. 

 

Figure 6L.  PL GFX HVB Coincident Control Properties Dialog Box – 
Date Range Tab 

 

 

DATE RANGE TAB 
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21. Select a date range (or time range) from the items listed in “Select Date 
Range” menu box in the “Date Range” tab of the “GFX HVB Coincident 
Control Properties” dialog box.  The table, given below, provides a list of 
options available to the user. 

 

Table 6D. List of Date Ranges 
 

 

• Last Month 

• This Month to Date 

• Last 30 Days 

• Last Week 

• This Week to Date 

• Last 7 Days Today 

• Today 

• Custom 

 

All of the items in the menu box, except “Custom”, define the range of time to 
extract data from a specified input channel (or topic). 

22. (Optional) Click “Custom…” in the “Date Range” tab within the “GFX HVB 
Coincident Control Properties” dialog box to define a customized date 
range.  This action activates the custom display selection boxes and text 
edit boxes as illustrated in the figure below.  The user has the option to 
select and modify the fields to define the custom time range.  Clicking the 
“Load Predefined” incorporates the custom time range.  Refer to Appendix 
B to define a custom date and time range. 

The “Allow To Change Period in Run Time” checkbox, if checked, permits a user 
to temporarily set a different time period for the GFX block.  When the GFX 
diagram is closed and re-opened, it reverts back to the original range. 

 

Figure 6M.  PL GFX HVB Coincident Control Properties Dialog Box 
– Device/Topic, Custom 
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The user may select other tabs to modify other features relating to the diagram 
object.  The figures, below and on the next page, illustrate the “Color”, “Font”, 
and “Picture” tabs.  The “Color” tab allows a user to change the background or 
foreground color of the diagram object.  The “Font” tab provides the user with the 
ability to modify the type, style, and size of a font, relating to character strings in 
the diagram object.  The “Picture” tab allows the user to attach a graphic image 
as a background image for the diagram object. 

 

Figure 6N.  PL GFX HVB Coincident Control Properties Dialog Box 
– Color Tab 

 

Figure 6O.  PL GFX HVB Coincident Control Properties Dialog Box 
– Font Tab 

OTHER TABS 
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Figure 6P.  PL GFX HVB Coincident Control Properties Dialog Box – 
Picture Tab 
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To edit a diagram object, the SMS client must be in the edit-mode.  Clicking the 
“View” menu indicates whether the diagram is in edit-mode or run-mode.  If the 
diagram is in edit-mode, then the “View>Edit Mode” menu item is gray and the 
“View>Run Mode” menu item is dark.  If the diagram is in run-mode, then the 
tint of the item entries in the “View” menu are vice versa.  Clicking the dark menu 
item disables the current mode and enables the other mode. 

If the diagram is in the run mode, and the diagram object has a refresh button in 
the upper-left hand corner, represented by the letter “R”, then the user has the 
option to press it.  Pressing the button accesses the data values from the on-
board data log, calculates the statistic, and displays it in the diagram object.  The 
figures, below and on the next page, illustrate a GFX diagram object in the edit 
mode and in the run mode. 

It is important to note the “R” button is only visible and functional if the user 
chooses this functionality during the creation of the GFX diagram object.  If the 
“refresh-on-demand” functionality is not chosen, then the diagram object does 
not have the button and the diagram is only produced for a single sample of data 
when the diagram is first opened. 

 

Figure 6R.  GFX Diagram Object in Edit Mode 

EDIT MODE (EDITING DIAGRAM 
OBJECT) VERSUS RUN MODE 
(ACTIVELY DISPLAYING DATA) 
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Figure 6Q.  GFX Diagram Object in Run Mode 
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Chapter 7 — Alarm Summary GFX Object 
 

This chapter describes how to set-up an Alarm Summary GFX object.  An Alarm 
Summary GFX object is a “compound object” that indicates if an out-of-limit or 
alarm condition occurs with one or more POWERLOGIC, Circuit Monitor, or 
WAGES topics.  An Alarm Summary GFX object is a combination of three GFX 
objects: a digital function block, a digital switch block, and a GFX alarm control 
object.  These three objects are stacked on top of each other to achieve the 
effect of an Alarm Summary, as illustrated below.  When stacked together, the 
digital switch block encloses the digital function block and the alarm object is 
hidden behind the digital function block and digital switch block. 

 

Figure 7A.  Combining Three GFX Objects to Create an Alarm 
Summary Object 

 

 

 

 

 

 

INTRODUCTION 

Digital Switch Block 

Digital Function Block 

Alarm Control Object 

Alarms Summary Object 
• Digital Switch Block 
• Digital Function Block 
• Alarms Object (Hidden) 

Stacking 3 GFX 
Objects on Top 
of Each Other to 
Create a Single 
Alarm Summary 
Object 
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The alarm control object monitors one or more alarm functions, each assigned to 
various topics (such as temperature, air pressure, gas flow).  If one of the alarm 
functions goes out-of-limits, then the alarm control object triggers a two-state 
custom quantity to go from “off” to “on”, indicating an alarm condition.  If all of the 
alarm functions are within limits, then the alarm control object triggers the 
custom quantity to go from “on” to “off”. 

The digital switch block, used to graphically represent an alarm (red) state or “no 
alarm” (green) state, gets its cue to trigger “red” or “green” from a digital function 
alarm monitoring the custom quantity.  The digital function block, used to display 
the alphanumeric text indicating an alarm or “no alarm”, also gets its cue from 
this same digital function alarm. 

 

The following procedures, illustrated in the table below, are necessary to 
construct an Alarms Summary GFX object. 

Note:  this chapter assumes that the user has a little understanding of 
constructing GFX diagrams, especially alarm objects.  However, the procedures 
should provide enough information to instruct the user on the complete set-up of 
an Alarms Summary GFX object.  To receive help or assistance in setting up an 
Alarms Summary GFX object, the user may consult Power Management 
Organization (PMO) technical support for help at 615-287-3400 or e-mail the 
support group at pmosuprt@squared.com. 

 

Table 7A.  Procedures for Setting Up an Alarm Summary Object 
 

Procedures for Setting Up an Alarm Summary Object 

 

Setting up Connection with the Database Driver 

Setting up Device/Routing for Alarm Summary Device 

Setting Up Custom Quantity for Alarm Summary GFX Object 

Creating a Global Alarm Function Using the Defined Custom Quantity 

Defining a Global Alarm Function for a Quantity (or Topic) 

Assigning a Global Alarm Function for a Custom Quantity (or Topic) to an Alarm Summary 
Device 

Assigning a Global Alarm Function for a Quantity (or Topic) to a Logical Device 

Creating  the Diagram to Contain the GFX Objects 

Creating the Alarm Control (GFX Object), a Component of the Alarm Summary GFX 
Object 

Creating the Digital Function Switch, a Component of the Alarm Summary GFX Object 

Creating the Digital Function Block, a Component of the Alarm Summary GFX Object 

Putting All of the GFX Objects Together to create the Alarm summary 

 

 

PROCEDURES FOR CONSTRUCTING 
AN ALARMS SUMMARY GFX 
OBJECT 
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It is necessary for the user to establish alarms for each device topic and an 
alarm for the custom topic, associated with the Alarm Summary GFX object.  In 
order to establish these alarms, the user must set up a connection with the 
database driver. 

1. Activate the SMS client. 

2. Click Setup>Communications Connection... menu item.  This action 
activates and displays the “Setup Communications Connection” dialog box 
illustrated in the figure on the next page. 

 

Figure 7B.  Setup Communication Dialog Box 

 

3. Click on the “Add…” button in the “Setup Communication” dialog box.  This 
action activates and displays the “Add Communication” illustrated in the figure 
below. 

 

Figure 7C.  Add Communication Connection Dialog Box 

 

PROCEDURE 1: SETTING UP 
CONNECTION WITH THE DATABASE 
DRIVER 
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4.     Enter a descriptive and meaningful name for the database driver in the 
“Communications Connection Name” text-edit box, found within the “Add 
Communication Connection” dialog box. 

5.     Select “Database Driver” in the “Communication Driver” menu box, found 
within the “Add Communication Connection” dialog box.  The following example 
illustrates key data filled in the “Add Communications Connection” dialog box. 

 

Figure 7D.  Example of “Add Communication Connection” Dialog 
Box with User-filled Data 

 

6. Press the “Continue” button in the “Add Communications Connection” 
dialog box.  This action activates and displays the “Communications Connection 
– Database Interface” dialog box. 

 

Figure 7E. “Communications Connection – Database Interface” 
Dialog Box 

 

7.     Press the “OK” button in the “Communication Connection” dialog box. 

This action activates and closes the “Communication Connection” dialog box and 
re-activates and displays the “Setup Communication” dialog box. 

8.     Click on the “Close” button in the “Setup Communication” dialog box.  This 
action closes the “Setup Communication” dialog box. 

 

This completes Procedure 1, “Setting Up Connection with the Database 
Driver”. 
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To construct an Alarm Summary GFX object, the user must define an “Alarm 
Summary” device.  The alarm summary device is a database device that does all 
of the “behind-the-scene” work for the alarm control GFX object.  The following 
procedure describes how to set-up a device/routing for an “Alarm Summary” 
device.  The alarm summary device is the device associated with the alarm 
control GFX object. 

Note:  the user must have a database connection already established to 
associate with the “Alarm Summary” device. 

1. Activate SMS client window. 

2. Click Setup>Devices/Routing... menu item.  This action activates and 
displays the “Setup Devices/Routing” dialog box illustrated in the figure 
below. 

 

Figure 7F.  Setup Devices/Routing Dialog Box 

 

3. Click on the “Add…” button in the “Setup Devices/Routing” dialog box.  This 
action activates and displays the “Add Device” dialog box illustrated in the figure 
below. 

 

Figure 7G.  Add Device Dialog Box 

PROCEDURE 2: SETTING UP 
DEVICE/ROUTING FOR ALARM 
SUMMARY DEVICE 
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4. Enter a name that best describes the alarm summary device in the “Device 
Name” text-edit box, found within the “Add Device” dialog box. 

5. Select “Generic_DBDrv” in the “Device Type” menu box, wound within the 
“Add Device” dialog box. 

6. Select the database connection, as defined in procedure 1, in the 
“Connection Name” menu box, found within the “Add Device” dialog box. 

The figure, illustrated below, demonstrates an example of data entered by a user 
into an “Add Device” dialog box. 

 

Figure 7H.  An Example of a Device Dialog Box with Data Entered 
by a User 

 

7.    Pressing the “OK” button in the “Add Device” dialog box activates and 
displays the “Database Communication Interface Driver” dialog box, as 
illustrated in the figure below. 

 

Figure 7I. Database Communication Interface Driver Dialog Box 
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8. Select the database connection, as defined in procedure 1, in the 
“Connection Name” menu box, found within the “Database Communication 
Interface Driver” dialog box. 

9. Select or enter a unique device ID (or SMS database table ID) between 1 
and 255 in the “Device ID” menu box, found within the “Database 
Communication Interface Driver” dialog box.  No other “database driver” device 
should have this ID. 

10. Select the appropriate data network protocol in the “Protocol” menu box, 
found within the “Database Communication Interface Driver” dialog box. 

The figure, below, illustrates an example of a “Database Communications 
Interface Driver” dialog box with user-entered data. 

 

Figure 7J. Example of a “Database Communication Interface 
Driver” Dialog Box w/User-entered Data 

 

11. Press the “OK” button to submit the data and close the “Database 
Communication Interface Driver” dialog box.  This action displays the “Setup 
Devices/Routing” dialog box.  In the “Devices Defined” menu box, the newly 
created alarm summary device appears along with the device type, the 
device address, the protocol, and the name of the database connection.  
The figure, illustrated below, shows an example of a newly created alarm 
summary device. 

 

Figure 7K. Example of a “Setup Devices/Routing” Dialog Box with 
Newly Created Alarm Summary Device 

 

Newly Created Alarm 
Summary Device Named 

“Surrey Twickenham 
District” 

Device type for Alarm 
Summary Device – 
“Generic_DBDrv” 



 

 
 2007 Schneider Electric, All Rights Reserved  Doc:  3070IB0701 Page 59 

WAGES SMS Add-on Reports & GFX Objects 
Instruction Bulletin 

 

12. Click on the “Close” button in the “Setup Devices/Routing” dialog box.  This 
action closes the “Setup Devices/Routing” dialog box. 

 

This completes Procedure 2, “Setting Up Device/Routing for Alarm 
Summary Device”. 
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To create an Alarm Summary GFX Object, the user must set up a custom 
quantity.  The custom quantity is the parameter that indicates “on” (or a value of 
“1”) if one or more alarm functions, associated with the alarm control object, are 
out-of-limits. Or, it indicates “off” (or a value of “0”) if all alarm functions, 
associated with the alarm control object, are within limits. This procedure 
describes how to create a custom quantity for an alarm control GFX object, 
assigning it to the database device. 

Note:  the upcoming series of steps create the custom quantity for an Alarm 
Summary GFX Object. 

1. Activate the SMS client. 

2. Click on the “Set-up>Custom Quantities…” menu item.  This action 
activates and displays the “Setup Custom Quantities” dialog box.  Be sure 
that the “Setup Quantities” tab is selected.  The figure, below, illustrates the 
“Setup Custom Quantities” dialog box with the “Setup Quantities” tab 
selected. 

 

Figure 7L. Setup Custom Quantities Dialog Box with the “Setup 
Quantities” Tab Selected 

 

3. Click the “Add” button in the “Setup Custom Quantities” dialog box.  This 
action activates and displays the “Edit Custom Quantity” dialog box. 

 

PROCEDURE 3: SETTING UP 
CUSTOM QUANTITY FOR ALARM 
SUMMARY GFX OBJECT 
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Figure 7M. Setup Custom Quantities Dialog Box 

 

4. Enter abbreviation in the “Abbreviation Name” text-edit box, found within the 
“Edit Custom Quantity” dialog box. 

5. Enter quantity name in the “Quantity Name” text-edit box, found within the 
“Edit Custom Quantity” dialog box. 

The following figure illustrates an example of data enter by the user in the “Edit 
Custom Quantity” dialog box. 

 

Figure 7N. Example of Data Entered by the User in the Setup 
Custom Quantities Dialog Box 

 

6. Click the “OK” button in the “Edit Custom Quantity” dialog box.  This action 
activates and displays “Setup Quantities” tab in the “Setup Custom 
Quantities” dialog box. 

7. Check the “Loggable” checkbox in the “Setup Quantities” tab of the “Setup 
Custom Quantities” dialog box. 

8. Check the “Digital Function” checkbox in the “Setup Quantities” tab of the 
“Setup Custom Quantities” dialog box. 

9. Make sure that the “Format Code” menu box has “Digital Function” selected.  
The custom quantity, being set up, is to have a Boolean state of either alarm or 
nominal condition, to be implemented by the Alarm Summary GFX Object. 

The figure, on the next page, illustrates a “Setup Custom Quantities” dialog box 
with user-entered data. 
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Figure 7O. Example of Data Entered by the User in the Setup 
Custom Quantities Dialog Box 

 

Note: the actions already taken in the previous steps have created the custom 
quantity.  The next steps involve assigning the custom quantity to the database 
device. 

10.  Select the “Assign Quantities” tab in the “Setup Custom Quantities” dialog 
box.  This action displays the tab as illustrated below.  (Be sure to answer “yes” 
when queried to save settings defined in the “Setup Quantities” tab.) 

 

Figure 7P. Setup Custom Quantities Dialog Box with the “Assign 
Quantities” Tab Selected 

 

 

 

 

 

 

 

 

 

 

 

 

This area should be 
populated with one or more 
custom quantities.  It 
should, at least, have the 
newly created custom 
quantity. 
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11. In the “Assign Quantities” tab of the “Setup Custom Quantities” dialog box, 
select and drag the custom quantity, listed within the “Available User Defined 
Quantities” list box to the “Device Supported Quantities” list box.  The “Available 
User Defined Quantities” list box is on the left-hand side of the dialog box.  The 
“Device Supported Quantities” list box is on the right-hand side of the dialog box. 

The “selecting-and-dragging” the custom quantity to the “Device Supported 
Quantity” list box activates and displays the “Setup Register for Quantity” dialog 
box.  In this dialog box, the user defines a unique SMS database address to the 
custom quantity. 

 

Figure 7Q. Setup Registers for Quantity Dialog Box 

 

12. Enter a unique value between 1001 and 1050 in the “1” (Register 1) text-edit 
box, found within the “Setup Registers for Quantity” dialog box.  The value 
should not be the same for any other custom quantity.  Enter zero in the “2” 
(Register 2) text edit box, found within the “Setup Registers for Quantity” dialog 
box. 

13. Make sure the data type in the “Data Type” menu box is “Holding Register 
(R03/W16W06)”. 

The figure, below, illustrates an example of a “Setup Registers” dialog box with 
user-entered data. 

 

Figure 7R. Example of a Setup Registers for Quantity Dialog Box 
with User-entered Data 
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14.   Click the “OK” button in the “Setup Registers for Quantity” dialog box.  This 
action de-activates the “Setup Registers for Quantity” dialog box and displays 
the “Setup Bitmask” dialog box.  The figure, below, illustrates the “Setup 
Bitmask” dialog box. 

 

Figure 7S. Example of a Setup Registers for Quantity Dialog Box 
with User-entered Data 

 

 

15. In the “Setup Bitmask” dialog box, select “On/Off” in the “Status Name” 
menu box.  Click and re-click register square “0” so that it changes from “X” to 
“0” to “1”, as illustrated in the above figure. 

16. Click the “OK” button in the “Setup Bitmask” dialog box.  This action de-
activates the “Setup Bitmask” dialog box and redisplays the “Setup Custom 
Quantities” dialog box. 

The figure, below, illustrates a custom quantity, named “Surrey Twickenham 
District Qty”, that is assigned to a database device.  The figure, below, is an 
example. 

 

Figure 7T. Example of a Assigned Custom Quantity 

 

Register Square 0 
(Having a Value of “1”) 
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17. Click the “Close” button in the “Setup Custom Quantities” dialog box.  This 
action activates and displays an SMS Message box indicating to shut down the 
client and server and restart them.  The figure, below, illustrates the message 
box. 

 

Figure 7U. SMS Message Dialog Box for Shutdown & Restart 

 

18. Click “OK”, shutdown the SMS client and server, and restart them. 

 

This completes Procedure 3. 
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This procedure instructs the user to create a global alarm function to monitor the 
state of the custom Boolean quantity, defined in procedure 3.  The function 
monitors the state of the custom quantity, triggered by the alarm summary 
device.  The alarm control GFX, via the alarm summary device, triggers the state 
based on the “alarm” or “no alarm” conditions of the alarm functions that it 
monitors for various topics. 

1. Activate the SMS client. 

2. Click on the “Setup>Functions/Alarms…” This action activates and 
displays the “Setup Functions” dialog box.  By default, the “Assign Functions” tab 
is selected in the “Setup Function” dialog box.  Click on the “Global Functions” 
tab.  The figure, below, illustrates the “Setup Functions” dialog box. 

 

Figure 7V. Setup Functions Dialog Box 

 

3.    Click on the “Add” button in the “Global Functions” tab of the “Setup 
Functions” dialog box.  This action activates and displays the “Add Global 
Function” dialog box.  The figure, below, illustrates the “Add Global Function” 
dialog box. 

 

 

 

 

PROCEDURE 4: CREATING A 
GLOBAL ALARM FUNCTION USING 
THE DEFINED CUSTOM QUANTITY 
FOR ALARM SUMMARY GFX 
OBJECT 
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Figure 7W. Add Global Function Dialog Box 

 

4. Select “Generic_DBDrv” in the “Device Type” box 

5.    Select the custom quantity listed in the “Quantity” menu box, located within 
the “Add Global Function” dialog box.  The custom quantity is the parameter 
defined in Procedure 3.  The digital alarm function is to monitor the state of this 
custom quantity. 

6.    Make sure that the “Digital” radio button is checked for “Function Type” in 
the “Add Global Function” dialog box. 

 

The figure, illustrated below, provides an example of a “Add Global Function” 
dialog box with user-entered data. 

 

Figure 7X. Example of Add Global Function Dialog Box with User-
entered Data 

 

This area lists the 
available custom 
quantities to use in 
developing an alarm 
function. 
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7. Click on the “OK” button in the “Add Global Function” dialog box.  This 
action activates and displays the “Global Functions” tab of the “Setup Functions” 
dialog box.  The “Global Functions” tab should now display the custom quantity 
under the “Digital” folder in the tree control list entitled “Functions”.  The figure, 
below, illustrates an example of a custom quantity, newly assigned as an alarm 
function. 

 

Figure 7Y.  Example of a Custom Quantity, Newly Assigned as an 
Alarm Function, as Displayed in the “Setup Functions” Dialog Box 

 

8.     Click on the “Setpoints” button in the “Global Function” tab of the “Setup 
Functions” dialog box.  This action activates and displays the “Edit Setpoints” 
dialog box.  The figure, below, illustrates the “Edit Setpoints” dialog box. 

 

Figure 7Z.  Edit Setpoints Dialog Box 

 

Device Type displays 
“Generic_DBDrv” 

Device Type:  “Generic_DBDrv” “Function” Text-edit Box and 
“Quantity” Text-edit Box have the 
custom quantity identified. 
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Note: the next series of steps define the minimum requirement to configure a 
global alarm function, used in setting up the Alarm Summary GFX object.  The 
user may reference pre-existing SMS documentation or take POWERLOGIC 
University courses to gain a greater understanding of setting up an alarm in 
greater detail. 

9. In the “Name” text-edit box of “Equal” controls box in the “Edit Setpoints” 
dialog box, enter the character string that the digital function block (GFX 
Object) would display if the custom quantity is in an “alarm” or “out-of-limit” 
condition. 

10. In the severity level menu box in the “Equal” controls box, select the severity 
level to a level higher than the “Non-equal” severity level. 

11. In the “Name” text edit box of “Non-Equal” controls box in the “Edit 
Setpoints” dialog box, enter the character string that the digital function 
block (GFX Object) would display if the custom quantity is in a “nominal” or 
“in-limit” condition. 

12. In the severity level menu box in the “Non-Equal” controls box, select the 
severity level to a level lower than the “Equal” severity level, preferably level 
9. 

13. Enter the delay time (in seconds) in the “Delay” text-edit box of the “Edit 
Setpoints” dialog box. 

14. Enter the poll interval (in seconds) in the “Poll Interval” text-edit box off the 
“Edit Setpoints” dialog box. 

At this point of the procedure, the user may close the dialog box, or may further 
define tasks to initiate when alarm or nominal conditions occur.  The figure, 
below, illustrate an “Edit Setpoints” dialog box with minimum amount of data 
filled by the user to successfully set up an alarm function used in an Alarms 
Summary GFX object. 

 

Figure 7AA.  Example of Edit Setpoints Dialog Box with User-enterd 
Data 
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15. Click on the “Close” button in the “Edit Setpoints” dialog box.  This action 
closes the dialog box and activates and displays the “Setup Functions” dialog 
box. 

16. Click on the “Update” button in the “Setup Functions” dialog box. 

17. Click on the “Close” button in the “Setup Functions dialog box. 

This completes Procedure 4, “Creating a Global Alarm Function Using the 
Defined Custom Quantity”. 
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This procedure describes the minimum steps required to set up a global alarm 
function for a topic.  The alarm function for a topic is one of many alarm functions 
monitored by the alarm control GFX object.  The user may re-use and repeat this 
procedure to create multiple global alarm functions for devices. 

Note:  this procedure assumes that the user has familiarity with setting up SMS 
alarms.  The purpose of having this procedure is to make the user aware that 
alarm functions for logical devices and SMS topics need to exist when creating 
an Alarm Summary GFX object.  The alarm function of an Alarm Summary GFX 
object requires one or more device or SMS topic alarm functions to monitor.  
Having no alarm functions to monitor makes the Alarms Summary GFX object 
useless. 

1. Activate the SMS client. 

2. Click “Setup>Function/Alarms…” menu item.  This action activates and 
displays the “Setup Functions” dialog box.  Select the “Global Functions” 
tab.  The figure, below, illustrates the “Global Functions” tab of the “Setup 
Functions” dialog box. 

 

Figure 7AB. Setup Functions Dialog Box 

 

3. Click the “Add” button in the “Setup Functions” dialog box.  This action 
activates and displays the “Add Global Function” dialog box.  The figure, on the 
next page, illustrates the “Add Global Function” dialog box. 

 

 

 

PROCEDURE 5: DEFINING A 
GLOBAL ALARM FUNCTION FOR A 
QUANTITY (OR TOPIC) MONITORED 
BY AN ALARM SUMMARY OBJECT 
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Figure 7AC. Add Global Function Dialog Box 

 

4. Select an available logical device type in the “Device Type” text-edit box of 
the “Add Global Function” dialog box.  For WAGES, the logical device type may 
be Water, Air, Gas, etc.  Upon selecting the device type, the “Quantity” list box 
displays the available quantities. 

5. Select the appropriate quantity to monitor for alarm condition in the 
“Quantity” list box of the “Add Global Function” dialog box.  Selecting a quantity 
in the “Quantity” list box populates the “Name” text-edit box automatically. 

6. Depending on the type of quantity, click either the analog or digital radio 
button in the “Add Global Function” dialog box. 

7.    Click the “OK” button in the “Add Global Function” dialog box.  This action 
closes the dialog box and re-activates and displays the “Setup Function” dialog 
box.  Click on the “Setpoints” button in the “Setup Function” dialog box.   

Depending on the type of function selected in the “Add Global Functions” dialog 
box, either the “Global Analog Function” dialog box, illustrated below, or the 
“Global Digital Function” dialog box, illustrated on the next page, appears. 

 

Figure 7AD. Edit Setpoints – Global Analog Function Dialog Box 

 

Name of Standard or Custom 
Quantity 

Device Type being “Logical 
Device” – for WAGES, it may 
be Water, Air, Gas, etc. 

List of Available Quantities 
for Device 
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Figure 7AE. Edit Setpoints - Global Digital Function Dialog Box 

 

8.     Enter the appropriate data and set the appropriate attributes in the “Edit 
Setpoints” dialog box to construct an alarm function appropriate to the 
application at hand. 

9. Click the “Close” button in the “Edit Setpoints” dialog box. 

10. Click the “Update” button in the “Setup Functions” dialog box. 

At this point in the procedure, the user may repeat steps 3 through 10 in this 
procedure to create another alarm function for a device topic. 

11 Click the “Close” button in the “Setup Functions” dialog box. 

This completes Procedure 5. 
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This procedure describes how to assign a global alarm function, for a custom 
quantity, to an alarm summary device.  (Procedure 2 describes the creation of an 
alarm summary device.  Procedure 4 describes the creation of a global alarm 
function.)  An alarm summary device requires assignment of a global alarm 
function to monitor alarm conditions for a particular data value that it monitors. 

1. Activate the SMS client. 

2.    Click “Setup>Function/Alarms…” menu item.  This action activates and 
displays the “Setup Functions” dialog box.  Select the “Assign Functions” tab.  
The figure, below, illustrates the “Assign Functions” tab of the “Setup Functions” 
dialog box. 

 

Figure 7AF.  “Assign Functions” Tab of “Setup Functions” Dialog 
Box 

 

3. Select the device to assign the alarm function for the custom quantity 
defined in procedure 4. 

4. Select the alarm function for the custom quantity in the “Functions Available” 
list box.  Press the “>” button to assign the alarm function to the selected device.  
This action displays the function in the “Functions Selected” dialog box. 

5.    Click the “Update” button in the “Assign Functions” tab of the “Setup 
Functions” dialog box. 

6.    Click the “Close” button in the “Assign Functions” tab of the “Setup 
Functions” dialog box. 

This completes Procedure 6 – Follow-up to Procedure 4”. 

PROCEDURE 6: ASSIGNING A 
GLOBAL ALARM FUNCTION FOR A 
CUSTOM QUANTITY (OR TOPIC) TO 
AN ALARM SUMMARY OBJECT 

Unassigned Global 
Functions of Custom 
Quantities 

Global Functions of 
Custom Quantities 
Assigned to Device 

Menu List to Select Device 
to Assign Custom Quantity 
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This procedure describes how to assign a global alarm function for a custom or 
standard quantity or topic defined in procedure 5 to a logical device.  A logical 
device requires assignment of a global alarm function to monitor alarm 
conditions for a particular data value that it monitors. 

1. Activate the SMS client. 

2.    Click “Setup>Function/Alarms…” menu item.  This action activates and 
displays the “Setup Functions” dialog box.  Select the “Assign Functions” tab.  
The figure, below, illustrates the “Assign Functions” tab of the “Setup Functions” 
dialog box. 

 

Figure 7AG.  “Assign Functions” Tab of “Setup Functions” Dialog 
Box 

 

3. Select the device to assign the alarm function for the custom quantity 
defined in procedure 5. 

4. Select the alarm function for the custom quantity in the “Functions Available” 
list box.  Press the “>” button to assign the alarm function to the selected device.  
This action displays the function in the “Functions Selected” dialog box. 

5. Click the “Update” button in the “Assign Functions” tab of the “Setup 
Functions” dialog box. 

6. Click the “Close” button in the “Assign Functions” tab of the “Setup 
Functions” dialog box. 

This completes Procedure7 – Follow-up to Procedure 5”. 

 

PROCEDURE 7: ASSIGNING A 
GLOBAL FUNCTION FOR A 
QUANTITY (OR TOPIC) BEING 
MONITORED BY AN ALARM 
SUMMARY OBJECT 

Unassigned Global 
Functions for Standard or 
Custom Quantities 

Global Functions for 
Standard or Custom 
Quantities Assigned to 
Device 

Menu List to Select 
Device to Assign 
Standard or Custom 
Quantity 
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This procedure describes how to create the GFX diagram to hold the Alarm 
Summary Object. 

 

1,     Click on the menu item “File>New>Diagram”.  This action activates and 
displays a dialog box querying the user whether or not to select a background 
image for the window.  The query dialog box is illustrated below.  Selecting “Yes” 
activates and displays a dialog box allowing the user to select a background 
image. 

Note:  at this point, the user may click the “Yes” button to use a background 
image for the diagram and then proceed to the next step in this procedure upon 
completion of this task.  Or the user may click on the “No” button to directly 
continue to the next step in the procedure.  The next step in this procedure is 
when the user completes the selection of a background or does not opt to create 
a background image for the diagram. 

 

Figure 7AH.  Dialog Box Querying User for Background Image for 
Diagram 

 

After selecting a background image or opting not to do so, a newly created GFX 
diagram appears as illustrated on the next page. 

 

PROCEDURE 8: CREATING THE 
DIAGRAM TO CONTAIN THE GFX 
OBJECTS 

 



 

 
 2007 Schneider Electric, All Rights Reserved  Doc:  3070IB0701 Page 78 

WAGES SMS Add-on Reports & GFX Objects 
Instruction Bulletin 
 

 

Figure 7AI.  Newly Created GFX Display 

 

2. Right-click to activate and display the “GFX Options” dialog box.  The dialog 
box has tabs, allowing the user to modify various features relating to the 
diagram. 

Note: at this point, the user may click the “Cancel” button to escape from the 
“GFX Options” dialog box or click on the different tabs and apply the features 
described below. 

The “Diagram Background Color” tab modifies the background color of the 
diagram.  The figure on the next page illustrates this dialog box. 

The “Grids Settings” tab defines whether or not a grid is present in the diagram 
and allows for a “snap-into-place” feature for the placement and movement of 
diagram objects.  The figure on the next page illustrates the dialog box. 

The “Drawing Size” tab defines the size of the diagram object.  The figure, on the 
second page from this page, illustrates the dialog box. 
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Figure 7AJ.  GFX Options Dialog Box – Diagram Background Color 
Tab 

 

Figure 7AK.  GFX Options Dialog Box – Grid Settings Tab 
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Figure 7AL.  GFX Options Dialog Box – Drawing Size 
 

 

3. Close the GFX Diagram or continue to the next set of procedures to insert 
the GFX objects necessary for constructing the Alarm Summary GFX object. 

This completes Procedure7, “Creating the Diagram to Contain the GFX 
Objects”. 
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This procedure is where the user inserts the alarm control (GFX object), used in 
the composition of the Alarm Summary Object.  The alarm control monitors one 
or more analog or digital alarm functions for various topics.  If one or more of the 
alarm functions goes “out-of-limits”, the alarm control triggers the custom 
quantity (defined in procedure 3) to go from an “off” state to an “on” state.  If all 
of the alarm functions are within limit, it triggers the custom quantity to an “off” 
state. 

1. Activate the SMS Client. 

2. Create or open a GFX diagram, if not already. 

3. Pressing the “Insert” key on the keyboard or clicking the “Edit>Insert GFX 
Object…” menu item activates and displays “Insert GFX Object” dialog box, as 
illustrated in the figure below. 

 

Figure 7AM.  Insert GFX Object Dialog Box 

 

4. Select “OLE Control Selection” in the “Insert GFX Object” dialog box and 
click the “OK” button. 

This action causes the “Insert GFX Object” dialog box to disappear, activating 
and displaying the “OLE Control Selection” dialog box.  The figure, below, 
illustrates the “OLE Control Selection” dialog box. 

 

 

PROCEDURE 9: CREATING THE 
ALARM CONTROL (GFX OBJECT), A 
COMPONENT OF THE ALARM 
SUMMARY GFX OBJECT 
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Figure 7AN.  OLE Control Selection 

 

5. Select “PL_GFX_Alarms.AlarmsCtrl” in the “OLE Control Selection” dialog 
box and click on the “OK” button. 

This action causes the “OLE Control Selection” dialog box to disappear, re-
activating the GFX dialog window and invoking the appearance of a “cross-hair” 
cursor. 

Select an area of the diagram that is to be the upper-left hand corner of the 
diagram object.  Pressing continuously down on the left mouse button, move in a 
right-downward (right-to-bottom), diagonal direction and release the mouse 
button at the area of the diagram that is to be the lower-right hand corner of the 
diagram object.  This action creates the newly created diagram object.  An 
example diagram, as illustrated in the figure on the next page, indicates how the 
newly created diagram object would appear. 

 

Figure 7AO. Newly Created GFX Diagram Object 
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6.     Double-click the newly created diagram object.  This action displays and 
activates the “PL_GFX_Alarms.AlarmCtrl Properties” dialog box.  The figure, on 
the next page, illustrates the initial view of the dialog box. 

 

Figure AP.  PL-GFX_Alarms.AlarmCtrl Properties 

 

7. Select the SMS system name in the “System Name” menu box in the 
“Alarms Control Properties” dialog box (3rd menu box from the bottom of the 
dialog box). 

8. Select the device in the “PowerLogic/WAGES Device” menu box in the 
“Alarms Control Properties” dialog box (2nd menu box from the bottom of the 
dialog box). 

9. Select the custom quantity for the alarm function in the 1st menu box from 
the bottom of the dialog box. 

10.   Click on the “Configure Alarm Groups” button.  This action activates and 
displays the “Alarm Object Configuration” dialog box.  The figure, on the next 
page, illustrates an example of the dialog box. 

 

 

 

 

 

SMS 3000 System SQL 

Caption Listed on the Control Block 

Position of Caption in Control 
Block 

Custom Quantity for Alarm Function 

Name of PowerLogic/WAGES Device 

Name of System 
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Figure AQ.  Example of an Alarm Object Configuration 

 

The name of the system, name of the PowerLogic/WAGES device, and the 
custom quantity for the alarm function should appear in the 1st, 2nd, and 3rd menu 
boxes from the top of the “Alarm Object Configuration” dialog box as they appear 
when selected in the “Alarms Control Properties” dialog box. 

11.   Select, from the list of available devices, in the bottom left menu box, in the 
“Alarms Object Configuration” dialog box, one or more devices, by double-
clicking them.  These devices are monitored the alarm summary object.  The 
devices, when selected, appear in the bottom right menu box in the “Alarms 
Object Configuration” dialog box. 

12. Click the “EXIT” button in the “Alarms Object Configuration” dialog box.  This 
action closes the dialog box, and re-activates and displays the “Alarms Control 
Properties” dialog box. 

13. Click the “Apply” button in the “Alarms Object Configuration” dialog box. 

14. Click the “OK” button in the “Alarms Object Configuration” dialog box. 

This completes Procedure 9, “Creating the Alarm Block, a Component of 
the Alarm Summary GFX Object”. 

 

 

 

Name of System 

Name of PowerLogic/WAGES Device 

Custom Quantity for Alarm Function 

List of Available Devices 

List of Selected Devices 
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This procedure is where the user inserts the digital switch block (GFX object) 
into the GFX object.  The custom quantity, defined in procedure 3, drives what 
character string gets displayed in the digital switch block.  The digital switch 
block displays a text string indicating an alarm state if the custom quantity is 
“on”.  Or, it displays a text string indicating a “no-alarm” state if the custom 
quantity is “off”. 

1. Activate the SMS Client. 

2. Create or open a GFX diagram, if not already open. 

3. Pressing the “Insert” key on the keyboard or clicking the “Edit>Insert GFX 
Object…” menu item activates and displays the “Insert GFX Object” dialog box, 
as illustrated in the figure below. 

 

Figure 7AR.  Insert GFX Object Dialog Box 

 

4. Select “Digital Function Switch” in the “Insert GFX Object” dialog box and 
click the “OK” button. 

This action causes the “Insert GFX Object” dialog box to disappear, re-activating 
the GFX dialog window and invoking the appearance of a “cross-hair” cursor. 

Select an area of the diagram that is to be the upper-left hand corner of the 
diagram object.  Pressing continuously down on the left mouse button, move in a 
right-downward (right-to-bottom), diagonal direction and release the mouse 
button at the area of the diagram that is to be the lower-right hand corner of the 
diagram object.  This action creates the newly created diagram object.  An 
example diagram, as illustrated in the figure on the next page, indicates how the 
newly created diagram object would appear. 

 

PROCEDURE 10: CREATING THE 
DIGITAL FUNCTION SWITCH, A 
COMPONENT OF THE ALARM 
SUMMARY GFX OBJECT 
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Figure 7AS.  Newly Created GFX Diagram Object 

 

5.    Double-click the newly created diagram object.  This action displays and 
activates the “PowerLogic Digital Function Switch Block Control Properties” 
dialog box.  The figure, below, illustrates the initial view of the dialog box. 

 

Figure 7AT.  PowerLogic Digital Function Switch Control Properties 
Dialog Box 

 

6.     Select the “General” tab of the “Digital Function Switch” dialog box. 
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7.     Select “Fill Box” in the “Switch Type” text-edit box of the “Digital Function 
Switch” dialog box, “General” tab. 

At this point of the procedure, the user may wish to modify any other attributes 
presented in the dialog box. 

8.     Select the “Device/Func” tab of the “Digital Function Switch” dialog box.  
The figure, illustrated below, illustrates the “Digital Function Switch” dialog box, 
“Device/Func” tab. 

 

Figure 7AU.  Device/Func Tab of Digital Function Switch Dialog Box 

 

9.    In the tree control list, entitled “Group/Device”, double-click on the alarm 
summary device that contains the digital function monitoring the custom quantity. 
The action displays the digital function associated with the device in the function 
selection box. 

Note: the alarm summary device is the device created in procedure 2.  The 
custom quantity is the topic created in procedure 3.  And the digital function is 
the alarm function created in procedure 4, to monitor the custom quantity. 

10.  Click on the digital function listed in the function selection box. 

11.  Click on the “Apply” button 

12. Click on the “OK” button 

This completes Procedure 10, “Creating the Digital Function Switch, a 
Component of the Alarms Summary GFX Object”. 
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This procedure is where the user inserts the digital function block into the GFX 
object.  The custom quantity, defined in procedure 3, drives what graphical color 
gets displayed in the digital switch block.  The digital switch block may display 
“red” indicating an alarm state if the custom quantity is “on”.  Or, it may display 
“green” indicating a “no-alarm” state if the custom quantity is “off”. 

1. Activate the SMS Client. 

2. Create or open a GFX diagram, if not already open. 

3. Pressing the “Insert” key on the keyboard or clicking the “Edit>Insert GFX 
Object…” menu item activates and displays “Insert GFX Object” dialog box, as 
illustrated in the figure below. 

 

Figure 7AV.  Insert GFX Object Dialog Box 

 

4. Select “Digital Function Block” in the “Insert GFX Object” dialog box and 
click the “OK” button. 

This action causes the “Insert GFX Object” dialog box to disappear, re-activating 
the GFX dialog window and invoking the appearance of a “cross-hair” cursor. 

Select an area of the diagram that is to be the upper-left hand corner of the 
diagram object.  Pressing continuously down on the left mouse button, move in a 
right-downward (right-to-bottom), diagonal direction and release the mouse 
button at the area of the diagram that is to be the lower-right hand corner of the 
diagram object.  This action creates the newly created diagram object.  An 
example diagram, as illustrated in the figure on the next page, indicates how the 
newly created diagram object would appear. 

 

PROCEDURE 11: CREATING THE 
DIGITAL FUNCTION BLOCK, A 
COMPONENT OF THE ALARM 
SUMMARY GFX OBJECT 
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Figure 7AW.  Newly Created GFX Diagram Object 

 

5.     Double-click the newly created diagram object.  This action displays and 
activates the “PowerLogic DigitalFuncBlock Control Properties” dialog box.  The 
figure, below, illustrates the initial view of the dialog box. 

 

Figure 7AX.  PowerLogic Digital Function Block Control Properties, 
General Tab 

 

6. Select the “General” tab in the “Digital Function Block” dialog box. 
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7. Enter the title of the Alarm Summary object in the “Title” text-edit box in the 
“Digital Function Block” dialog box, “General” tab. 

8. Enter a text for display when an alarm occurs in the “Equal” text-edit box in 
the “Digital Function Block” dialog box, “General” tab.  Likewise, do the same for 
the “Non-equal” text edit box. 

At this point of the procedure, the user may wish to modify any other attributes 
presented in the dialog box. 

9.    Select the “Device/Func” tab of the “Digital Function Block” dialog box.  The 
figure, below, illustrates the “Digital Function Block” dialog box, “Device/Func” 
tab. 

 

Figure 7AY.  Device/Func Tab of Digital Function Block Dialog Box 

 

10.  In the tree control list, entitled “Group/Device”, click on the alarm summary 
device that contains the digital function monitoring the custom quantity. This 
action displays the digital function associated with the device in the function 
selection box. 

Note: the alarm summary device is the device created in procedure 2.  The 
custom quantity is the topic created in procedure 3.  And the digital function is 
the alarm function created in procedure 4, to monitor the custom quantity. 

11. Click on the digital function listed in the function selection box. 

12. Click on the “Apply” button 

13. Click on the “OK” button 

This completes Procedure 11, “Creating the Digital Function Block, a 
Component of the GFX Object”. 
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Chapter 8 — WAGES Add-on Reports: Demand & Usage 
 

This chapter identifies and explains the availability of WAGES Add-on Reports 
for Demand and Usage.  It also gives a step-by-step description of how to create 
the add-on reports. 

It is important to remember two concepts concerning WAGES reports and 
WAGES data.  These concepts are “demand” and “usage”.  “Demand” is the 
maximum value of a logged series of averages.  “Usage” is calculated by 
subtracting the first available logged sample for the specified time period from 
the last available logged sample.  The resulting value is multiplied by the 
adjustment coefficient in order to estimate the usage for the entire requested 
period. The adjustment coefficient is calculated by dividing the entire report span 
by the time span between the first and the last available samples.  Usage must 
be associated with an accumulative topic in SMS. 

A WAGES Add-on Report consists of two major segments: the title block and the 
matrix table of information.  The figure, below, provides a general syntactical 
layout of a typical WAGES Add-on Report. 

 

Figure 8A. Syntactical Layout of a WAGES Add-on Report 
Title Block 

 

Matrix Table of Information 

 

 

 

Every WAGES Add-on Report has a title block at the top.  The table, given 
below, identifies the pieces of information in the title block. 

 

Table 8A. WAGES Add-on Reports Title Block 
 

 

SMS System Name 

Report Start Time (w/Date & Time) 

Report End Time (w/Date & Time) 

Report Generation Time (w/Date & Time) 

Database Server 

History DSN (Data Source Name)  

System DSN (System Source Name) 

 

INTRODUCTION 
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Every WAGES Add-on Report has a matrix table of information located below 
the title block.  The table, provided on this page and the pages to follow, lists the 
WAGES Add-on Reports, with a description of the matrix tables, available to the 
user.  

 

Table 8B. WAGES Add-on Reports (Table 1 of 5) 
 

 

Add-on Report Description 

  

Daily Usage Report This report attempts to provide a “day-by-day” usage of 
various resources from various metering & monitoring 
devices (defined in the data logging templates) over a 
specified amount of time.  The report is a table with the 
following columns. 

• “Date” is the starting date and time for the segment 
of time reported.  

• “Duration” is the amount of time in days, hours and 
minutes for the given segment.  Normally, duration is 
one (1) day per table entry.  However, anomalies in 
logging the data may produce a somewhat different 
duration for some table entries. 

• “Actual” is the actual amount of resource used, 
flowed, expended, etc. over the duration of time. 

• “Adj/Day” is adjusted amount per day.  If an anomaly 
occurs in duration for a table entry, the actual 
amount for the entry is adjusted to reflect a 
calculated estimation of amount per day. 

The report has the following rows, other than the 
individual duration entries, to identify key pieces of 
statistical information. 

• “Min” is the minimum adjusted amount per day in the 
report’s table entries. 

• “Max” is the maximum adjusted amount per day in 
the report’s table entries. 

• “Avg” is the average of all adjusted amounts per day 
in the report’s table entries. 

• “Total” is the total of all of the report’s table entries. 
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Table 8B. WAGES Add-on Reports (Table 2 of 5) 
 

 

Add-on Report Description 

  

Hourly Usage Report This report attempts to provide an “hour-by-hour” usage 
of various resources from various metering & monitoring 
devices (defined in data logging templates) over a 
specified amount of time.  The report is a table with the 
following columns. 

• “Date” is the starting date for the segment of time 
reported.  

• “Time” is the starting hours and minutes for the 
segment of time reported. 

• “Duration” is the amount of time in hours and 
minutes for the given segment.  Normally, duration is 
one (1) hour per table entry.  However, anomalies in 
logging the data may produce a somewhat different 
duration for some table entries. 

• “Actual” is the actual amount of resource used, 
flowed, expended, etc. over the duration of time. 

• “Adj/Day” is adjusted amount per hour.  If an 
anomaly occurs in duration for a table entry, then the 
actual amount for the entry is adjusted to reflect a 
calculated estimation of amount per hour. 

The report has the following rows, other than the 
individual duration entries, to identify key pieces of 
statistical information. 

• “Min” is the minimum adjusted amount per hour in 
the report’s table entries. 

• “Max” is the maximum adjusted amount per hour in 
the report’s table entries. 

• “Avg” is the average of all adjusted amounts per 
hour in the report’s table entries. 

• “Total” is the total of all of the report’s table entries. 
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Table 8B. WAGES Add-on Reports (Table 3 of 5) 
 

 

Add-on Report Description 

Main Usage Report This report, in a summary, provides total usage of various 
resources from various metering and monitoring devices 
(defined in the data logging templates) over a specified 
amount of time.  The report is a table with the following 
columns. 

• “Device” is the metering or monitoring device. 

• “Topic” is the topic descriptor associated with the 
input channel data value. 

• “Usage” is the total amount of the resource used, 
flowed, expended, etc. 

Detailed Usage 
Report 

This report, in detail, provides total usage of various 
resources from various metering and monitoring devices 
(defined in the data logging templates) over a specified 
amount of time.  It provides more information than the 
Main Usage Report.  The report is a table with the 
following columns: 

• “Device” is the metering or monitoring device. 

• “Topic” is the topic descriptor associated with the 
input channel data value. 

• “Usage” is the total amount of the resource used, 
flowed, expended, etc. 

• “From Date” is the date of the first available sample 
in the requested period. 

• “To Date” is the date of the last available sample in 
the requested period. 

• “Adj” is the “adjusted coefficient.  Usage values are 
calculated by subtracting the first available sample 
for the time period selected from the last one. The 
resulting value is multiplied by the adjustment 
coefficient in order to estimate the usage for the 
entire requested period. The adjustment coefficient 
is calculated by dividing the entire report span by the 
time span between the first and the last available 
samples. The coefficient used is displayed in this 
column. 
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Table 8B. WAGES Add-on Reports (Table 4 of 5) 
 

 

Add-on Report Description 

  

Peak Demand/Usage 
Report 

This report provides information about the peak demand 
and usage of resources from various metering and 
monitoring devices (defined in the logging template).  The 
report is a table.  The columns in the table provide the 
following information. 

• “Device” is the metering or monitoring device. 

• “Demand” is the topic descriptor associated with the 
input channel data value associated with peak 
demand. 

• “Avg/Demand” is the calculated average of logged 
samples over a specified period of time. 

• “Min” is the minimum logged sample (or data value) 
selected from a series of logged samples over a 
specified period of time. 

• “Date”, adjacent to “Min”, is the date and time of 
when the device logged the minimum sample. 

• “Max” is the maximum logged sample (or data value) 
selected from a series of logged samples over a 
specified period of time. 

• “Date”, adjacent to “Max” is the date and time of 
when the device logged the maximum sample.  

• “Usage” consists of two sub-columns of information.  
One is topic and the other is value.  The topic sub-
column is the topic descriptor associated with the 
input channel data value associated with usage.  
The value sub-column is the total usage for a 
specific period of time of the resource used, flowed, 
expended, etc. 

 

The figure, given below, illustrates an example of a WAGES Add-on Report. 

 

Figure 8B. Example of a WAGES Add-on Report 
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The following procedures described how to create a WAGES add-on report. 

Note 1: before generating a Demand/Usage Report for the first time, the user 
must run the Usage Table Manager, at least once, to identify which input 
channel data values or topics are classified as “usage”.  The report generation 
component of SMS requires this activity to be performed in order to discriminate 
between topics that are demand and topics that are usage.  Refer to Appendix A. 

Note 2: the “PowerLogic Reports Wizard”, a utility in the SMS Information 
Manager, is responsible for creating a WAGES Add-on Report, besides creating 
other types of reports from logged data.  There are two alternatives to starting up 
the SMS Information Manager.  Proceed to either step 1A for startup on the SMS 
Client or proceed to step 1B for startup on the SMS Server. 

1A. In the SMS Client, click the “Reports>Information Manager>Creation 
Wizard…” menu item.  This action activates and displays the SMS Information 
Manager window and automatically invokes the activation and display of the 
“PowerLogic Reports Wizard” to create a WAGES Add-on Report. 

1B. In the Windows PC Desktop, click “Start>All Programs>SMS-3000>SMS 
Information Manager” (v3.3.2) or “Start>All Programs>Powerlogic>SMS 
Information Manager” (v4.0) menu item.  This action activates and displays the 
SMS Information Manager window.  Click “File>New” menu item.  (If SMS is not 
running, then the user is queried for SMS account name and password.)  
Selecting a “new file” activates the “PowerLogic Reports Wizard” to create a 
WAGES Add-on Report. 

The figure, illustrated below, is the first page displayed on the “PowerLogic 
Reports Wizard”.  This is the “Welcome” page. 

 

Figure 8C. “Welcome Page” for the “PowerLogic Reports Wizard” 

 

2. Click the “Next>” button.  This action activates and displays the page to 
select the report desired for creation.  The menu box with the list of reports is on 
the left side of the page.  The standard PowerLogic reports have an “S” icon 
adjacent to them.  The customized or add-on reports have a “C” icon adjacent to 
them, including the WAGES Add-on Reports.  The figure, on the next page, 
illustrates the “report selection” page. 

CREATING A WAGES ADD-ON 
REPORT 
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3. Click one of the items in the menu box in the report selection page.  Each 
item is the name of a PowerLogic Report.  The choice for a WAGES Add-on 
Report may be one of the following. 

 
 

Daily Usage Report 
Demand-Usage Report 
Hourly Usage Report 

Usage-Detailed Report 
Usage-Main Report 

 
The figure, below, illustrates the “report selection” page. 

 

Figure 8D. “Report Selection” Page 

 

4.  Click the “Next>” button to activate and display the “Device Selection” page, 
illustrated on the next page. 

5. Select the desired PowerLogic or WAGES System from the “Systems” menu 
box in the “device selection” page. 

6. Select the available channel device from the metering or monitor device(s) 
listed in the “Available” tree control in the “Device Selection” page.  
Selection occurs when clicking on the channel device item in the tree and 
clicking on the “>” button.  This action invokes the metering and monitoring 
device with the selected device item to appear in the “Selected” tree control.  
The user may wish to repeat step six to select multiple devices to be in the 
report. 

 

Note: The Demand/Usage Report requires exactly one demand topic (or data 
value) and one usage topic (or data value) for each of the devices selected. 
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Figure 8E. “Device Selection” Page 

 

7. Click the “Next>” button on the “device selection” page.  This action 
activates and displays the “Date Range” page, as illustrated below. 

 

Figure 8F. “Date Range” Page 
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Note 2: the user may select a pre-defined date range by doing step 8A or the 
user may create and select a custom date range by doing step 8B. 

8A. Select the pre-defined date range in the “Pre-defined Data Range” menu 
box in the “Date Range” page.  Refer to appendix B to define custom date 
ranges. 

8B. Click the “Custom” button in the “date-range” page.  This action activates 
and displays a “Custom Data Range” block containing menu boxes to define the 
start and end times.  Select the start and end times.  The figure, below, 
illustrates an example of a “Date Range” page with the “Custom Data Range” 
block at the bottom part of the page.  (The figure, below, is merely an example 
and does not actually represent the values that the user sees.) 

 

Figure 8G. An Example of a “Date Range” Page with “Custom Data 
Range Block” 

 

9. Click the “Next>” button in the “Date Range” page.  This action activates 
and displays the “Save” page, as illustrated in the figure on the next page.  On 
this page, the user has the options to save the report by clicking on the “Save” 
check box.  By choosing to save the report, the user may wish to modify the 
name of the report via the “Report Name” text-edit box.  Or, the user may wish to 
change the directory where to store the reports.  The “Save” page also allows 
the user to save topics as a template, appearing on the next report generation 
for the user to choose. 
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Figure 8H. “Save” Page 

 

10. Click the “Next>” button in the “Save” page.  This action activates and 
displays the “Schedule” page, as illustrated in the figure below.  

 

Figure 8I. “Schedule” Page 
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The “Schedule” page allows the user to choose to run PowerLogic reports on a 
scheduled basis, automatically.  By checking the “Run the report” checkbox, the 
user has the capability to do a scheduled “print” by checking the “Print” checkbox 
or to overwrite a pre-existing report by checking the “Overwrite” checkbox.  The 
user also has the option to edit the schedule of running the report by pressing 
the “Edit Schedule” button.  (Pressing the button invokes a property page, 
allowing one to set and modify how a report is generated and maintained.) 

11. Click the “Next>” button in the “Schedule” page to activate and display the 
“Completion page”. 

 

Figure 8J. “Completion” Page 

 

12. Click the “Finish” button in the “Completion” page. 

 

This ends this procedure, “Creating a WAGES Add-on Report”. 
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Chapter 9 — WAGES Add-on Reports: Range Comparison 
 

This chapter identifies and explains the WAGES Add-on Report for Range 
Comparison.  It also gives a step-by-step description of how to create the add-on 
reports. 

The Range Comparison Report shows the current range of logged data values 
(or topics) with a baseline range of logged data values (or topics).  The term 
“current”, used in the phrase “current range”, indicates some range of start and 
end dates near or current to when the report is generated.  The term “baseline”, 
used in the phrase “baseline range”, indicates some range of start and end dates 
at some period of time before the current range.  This report is intended to 
illustrate to an audience the consumption, flow, expenditure, measurement, etc. 
for a current time range as compared to a previous time range.  A figure at the 
end of this chapter illustrates an example of a Range Comparison Report. 

The following describes the procedures necessary to generate a Range 
Comparison Report. 

 

Note 1: the PowerLogic Reports Wizard, a utility in the SMS Information 
Manager, is responsible for creating a WAGES Add-on Report, besides creating 
other types of reports from logged data.  There are two alternatives to starting up 
the SMS Information Manager.  Proceed to either step 1A for startup on the SMS 
Client or proceed to step 1B for startup on the SMS Server. 

1A. In the SMS Client, click on the “Reports>Information Manager>Creation 
Wizard…” menu item.  This action activates and displays the SMS Information 
Manager window and automatically invokes the activation and display of the 
PowerLogic Reports Wizard to create a WAGES Add-on Report. 

1B. In the Windows PC Desktop, click “Start>All Program>SMS-3000>SMS 
Information Manager” (v3.3.2) or “Start>All Program>Powerlogic>SMS 
Information Manager” (v4.0) menu item.  This action activates and displays the 
SMS Information Manager window.  Click “File>New” menu item. .  (If SMS is 
not running, then the user is queried for SMS account name and password.)  
Selecting a “new file” activates the “PowerLogic Reports Wizard” to create a 
WAGES Add-on Report. 

The figure, illustrated below, is the first page displayed.  This is the “Welcome” 
page. 

 

Figure 9A. “Welcome Page” 
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2. Click on the “Next>” button on the “Welcome Page”.  This action displays 
the “Add-on Report Selection” page, as illustrated in the figure below. 

 

Figure 9B. “Add-on Report Selection” Page 

 

3. Click on the “Add-on Report” in the menu box on the left side of the “Add-
on Report Selection” page. 

4. Click on the “Next>” button in the “Add-on Report Selection” page.  This 
action displays the 2nd “Add-on Report Selection” page, as illustrated in the 
figure below. 

 

Figure 9C. 2ND “Add-on Report Selection” Page 

 



 

 
 2007 Schneider Electric, All Rights Reserved  Doc:  3070IB0701 Page 104 

WAGES SMS Add-on Reports & GFX Objects 
Instruction Bulletin 
 

 

5. Click on “Range Comparison” in the menu box on the left side of the 2nd 
“Add-on Report Selection” page. 

6. Click on the “Next>” button in the 2nd “Add-on Report Selection” page.  This 
action displays the “Current Date Range Selection” page, as illustrated in the 
figure below. 

 

Figure 9D. “Current Date Range Selection” Page 

 

Note 2: the user may select a pre-defined date range by doing step 7A or the 
user may create and select a custom date range by doing step 7B. 

7A. Select the pre-defined date range in the “Pre-defined Data Range” menu 
box in the “Current Date Range Selection” page. Refer to appendix B to define 
custom date ranges. 

7B. Click the “Custom” button in the “Current Date Range Selection” page.  This 
action activates and displays a “Custom Data Range” block containing menu 
boxes to define the start and end times.  Select the start and end times and 
press the “Pre-defined” button.  The figure, above, illustrates an example of a 
“Current Date Range Selection” page with the “Custom Data Range” block at the 
bottom part of the page.  (The figure, above, is merely an example and does not 
actually represent the values that the user sees.) 

8. Click on the “Next>” button in the “Current Date Range Selection” page.  
This action displays the “Baseline Date Range Selection” page, illustrated on the 
next page. 
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Figure 9E. “Baseline Date Range Selection” Page 

 

Note 3: the user may select a pre-defined date range by doing step 9A or the 
user may create and select a custom date range by doing step 9B. 

9A. Select the pre-defined date range in the “Pre-defined Data Range” menu 
box in the “Baseline Date Range Selection” page. 

9B. Click the “Custom” button in the “Baseline Date Range Selection” page.  
This action activates and displays a “Custom Data Range” block containing 
menu boxes to define the start and end times.  Select the start and end times.  
The figure, above, illustrates an example of a “Baseline Date Range Selection” 
page with the “Custom Data Range” block at the bottom part of the page.  (The 
figure, above, is merely an example and does not actually represent the values 
that the user sees.) 

10. Click on the “Next>” button in the “Baseline Date Range Selection” page.  
This action displays the “Systems, Devices, and Topics” page, illustrated on the 
next page. 
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Figure 9F. “Systems, Devices, and Topics” Page 

 

11. Select the desired PowerLogic or WAGES System from the “Systems” menu 
box in the “Systems, Devices, and Topics” page. 

12. Select the available channel device from the metering or monitor device(s) 
listed in the “Available” tree control in the “Device Selection” page.  
Selection occurs when clicking on the channel device item in the tree and 
clicking on the “>” button.  This action invokes the metering and monitoring 
device with the selected device item to appear in the “Selected” tree control.  
The user may wish to repeat step twelve to select multiple devices to be in 
the report. 

13. Click the “Next>” button in the “System Device Topic” page.  This action 
activates and displays the “Save” page, as illustrated in the figure on the next 
page.  On this page, the user has the options to save the report by clicking on 
the “Save” check box.  By choosing to save the report, the user may wish to 
modify the name of the report via the “Report Name” text-edit box.  Or, the user 
may wish to change the directory where to store the reports.  The “Save” page 
also allows the user to save topics as a template, appearing on the next report 
generation for the user to choose. 
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Figure 9G. “Save” Page 

 

 

14. Click the “Next>” button in the “save” page.  This action activates and 
displays the “schedule” page, as illustrated in the figure below.  

 

Figure 9H. “Schedule” Page 
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The “schedule” page allows the user to choose to run PowerLogic reports on a 
scheduled basis, automatically. (The user has the option to skip this feature by 
clicking on the “Next” button.)  By checking the “Run the report” checkbox, the 
user has the capability to do a scheduled “print” by checking the “Print” 
checkbox or to overwrite a pre-existing report by checking the “Overwrite” 
checkbox.  The user also has the option to edit the schedule for running the 
report by pressing the “Edit Schedule” button. (Pressing the button invokes a 
property page, allowing one to set and modify how a report is generated and 
maintained.) 

15. Click the “Next>” button in the “Schedule” page to activate and display the 
“Completion page”. 

 

Figure 9I. “Completion” Page 

 

16. Click the “Finish” button in the “completion” page.  This action generates 
the “Range Comparison Report” illustrated on the next page. 
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Figure 9J.  An Example of a Range Comparison Report 

 

This ends this procedure.  
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Chapter 10 — Enhanced Cost Summary Report 
 

The Enhanced Cost Summary Report provides information on the cost or 
expenses of natural or energy-related resource usage.  Natural or energy-related 
resources may be water, (pressurized) air, gas, electricity, steam, etc. 

 

The following diagram provides a simplistic syntax of an enhanced cost 
summary report. 

 

Figure 10A. Syntax of an Enhanced Cost Summary Report 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

INTRODUCTION 

SYNTAX OF AN ENHANCED COST 
SUMMARY REPORT 

Report’s Introduction 
 

This section of the report contains the introductory material about its 
generation. 

 

System Name Name of Database Server 

Report Start Time Name of SMS History Database 

Report End Time Name of SMS System Database 

Date of Report Generation Time of Use Schedule Name 

 

Time-of-Use Start and End Times for Common or 
Special Event 

 
This section of the report identifies the time-of-use start and end times for a 
given series of days.  The report may have one or more of these sections 
for each common or special event.  

Device Cost Summary 
 

This section of the report provides a cost summary of resource usage from 
a device.  It identifies each time-of-use, its date-and-time, its unit cost, its 
quantity, and its cost.  It also provides miscellaneous costs as well.  The 
report may have one or more of these sections for each device. 
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The Information Manager Wizard allows a user to generate an enhanced cost 
summary report.  To generate the report, the reader is to read and perform the 
procedure as follows. 

1.  Activate and run the SMS client. 

2. Click on the menu item “Reports>Information Manager>Creation 
Wizard”.  This action displays and activates the dialog box, illustrated below. 

 

Figure 10B. Initial Welcome Page 
 

 

 

GENERATING THE ENHANCED 
COST SUMMARY REPORT USING 
THE INFORMATION MANAGER’S 
WIZARD 
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3. Click on the “Next” button on the “Welcome” page.  This action activates 
and displays the next page, as illustrated below.  This 2nd Welcome page 
contains a list of reports. 

 

Figure 10C. Welcome Page with List of Reports 
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4. Select “Enhanced Cost Summary” in the selection list and click on the 
“Next” button on the 2nd “Welcome” page.  This action activates and displays the 
next page, as illustrated below.  This page is the “Device Selection Page”. 

 

Figure 10D. Device Selection Page 
 

 

On this page, the user selects the devices, representing various metering or 
monitoring equipment, to display the usage topics in the report.  By selecting the 
device in the left column, entitled “Available” and clicking the “>” button, the 
items are put into the “Selected” column. 
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5. Click on the “Next” button on the device selection page.  This action 
activates and displays the next page, as illustrated below.  This page is the “Cost 
Summary Input Page”. 

 

Figure 10E. Cost Summary Input Page 
 

 

The cost summary input page provides tabs to define general cost data, time-of-
usage (TOU) information, and “special day” usage data for the report. 
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The general tab provides information about general cost data for the report.  The 
figure, below, illustrates this tab and identifies and describes the key fields, 
located in the tab. 

 

Figure 10F. Cost Summary Input Page – General Tab 
 

 

 

 

 

 

 

 

 

 

 

 

 

“Main Device” selection 
box allows a user to 
optionally choose the 
main device to be in the 
report. 

“Demand Coincident” checkbox 
generates a report where the device 
demand is coincidental to the main 
device or to the sum of all devices in 
the report.  Refer to the figure on the 
next page for further understanding on 
this relationship. 

The TOU (Time-of-
usage) checkbox 
enables the TOU Setup 
and Special Days tabs.  
These tabs define the 
information associated 
with TOU and special 
days. 

“Charge Name” field 
indicates the name of 
charge, expense, or 
cost. 

“Topic” field is a 
selection box indicating 
the type of resource, 
such as water, air, gas, 
electricity, or steam. 

“Non-TOU” field is the 
field defined for charges 
not related to time-of-
usage. 

Miscellaneous charges 
table, allowing user to 
define name of the 
charge and the rate of 
usage. This area holds any “time-of-

usage” columns.  Each 
column contains the cells to 
hold the “time-of-usage” costs 
for each charge.  “Time-of-
usage” subjects or topics are 
defined in the “TOU Setup” 
tab. 
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Figure 10G. Coincidental Demand / Peak Demands 
 

 

 

 

 

 

 

 

 

 

 

 

 

Coincidental 
Event 

Main 
Device 

Selected? 

Demand 
Coincident 
Selected? 

Report Content 

 

Peak Demand 
of Main Device 

Yes Yes Report shows the demand of non-
main devices or feeder devices, 
coincidental to the peak demand of 
the main device.  The main device 
is the first device, providing 
demand & usage information, with 
other devices following. 

None Yes No Report contains peak demand and 
total usage of each device.  The 
main device is the first device in 
the report.  There is no 
coincidental demand relationship 
in the report. 

Peak Demand 
of Sum 

No Yes Report shows the peak demands 
of non-main devices, coincidental 
to the peak demand of their sum.  
Total usage is provided for each 
device. 

None No No Report contains peak demand and 
total usage for each device in 
report.  The main device is not 
present in the report.  There is no 
coincidental relationship in the 
report. 

 

 

 

Sum of Non-main 
Demands 

Device B Demand 

Peak Demand for Sum of All Non-main Demands in Report Peak Demand for Main Demand 

Main Demand 

Device A Demand 

Peak Demand 
for Device B 

Peak Demand 
for Device A 
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Important! The user needs to define the time-of-usage (TOU) in the “TOU 
Setup” tab before completing the information in the general tab, if TOU is 
used in the report.  To enable the “TOU Setup” tab, check the “TOU” 
checkbox in the general tab. 

The figure, below, illustrates an example of a general tab with TOU already 
defined, using the “TOU Setup” tab. 

 

Figure 10H. Cost Summary Input Page – Example of a General Tab 
with TOU Information 
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The TOU setup tab allows the user to define standard and custom time-of-usage 
time periods.  One may define standard periods, such as off-peak, mid-peak and 
on-peak periods.  Or, one may define a custom period, outside the traditional 
definition of peak periods.  The figure, below, illustrates this tab when initially 
created without any selected TOU schedule (names). 

 

Figure 10I. Cost Summary Input Page – TOU Setup Tab, Initial View 
 

 

Clicking the “New” button creates a new TOU schedule.  The figure, below, 
illustrates a newly created TOU schedule. 

 

Figure 10J. Cost Summary Input Page – TOU Setup Tab with New 
Schedule Name Text Edit Box 
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In the “TOU Setup” tab, enter the new schedule name in the “Enter New 
Schedule Name” text edit box and click the “Add” button.  This action causes the 
text edit box, defining the schedule name, to disappear, and invokes the display 
of a “Time-of-Use” data column, as illustrated below. 

 

Figure 10K. Cost Summary Input Page – TOU Setup Tab with Newly 
Created Time-of-Use Column 

 

 

In the “Time-of-Use” data column, enter TOU periods, such as “off-peak”, “mid-
peak”, or “on-peak”.  The TOU period may be names custom or specific to the 
usage of the resource by the user.  After entering the periods, the “Day 
Template” data column appears.  (If the column does not appear, then click in 
the “Time-of-Use” data column to make it appear.)  The figure, illustrated on the 
next page, shows the tab with “Day Template” data column. 
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Figure 10L. Cost Summary Input Page – TOU Setup Tab with Newly 
Created Day Template Column 

 

 

The “Day Template” defines the period of days representing a common or 
special event.  Common events may be “weekday” or “weekend”.  Entering the 
data in the “Day Template” data column invokes the display of the remaining 
fields.  The figure, on the next page, identifies the fields in the tab. 
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The figure, below, illustrates an example of a TOU setup tab with defined data.  
The caption boxes identify the various fields in the “TOU Setup” tab. 

 

Figure 10M. Cost Summary Input Page – Example of a TOU Setup 
Tab with TOU Information 

 

 

 

 

 

 

 

 

 

 

“Day Template” defines 
common or special days, 
such as “weekend”, 
“weekdays”, or “holidays”. 

“Time-of-Use” defines the 
peaks in resource usage.  
The peaks may be traditional 
“off-peak”, “mid-peak”, or 
“on-peak”, or a custom peak 
period. 

Section box for schedule 
name allows users to select a 
specific schedule to view or to 
modify.  “New” button creates 
new schedules.  “Delete 
button deletes schedules. 

“Day of the Week” 
checkboxes defining the 
days associated with “Days 
Template”. 

“Day Time Bands” data columns define 
the start and end times for specific time-
of-use periods. 
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The “Special Days” tab allows the user to define special days.  The user can 
define the exact date and what “Day Template” is associated with the special 
day.  The figure, below, illustrates a special days tab. 

 

Figure 10N. Cost Summary Input Page – Special Days Tab 
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6.  After filling out the appropriate information in the cost summary input page, 
click on the “Next” button.  This action activates and displays the “Data Range 
Selection Page”, as illustrated below.  Select the appropriate date range.  Refer 
to appendix B to define custom date ranges. 

 

Figure 10O. Data Range Selection Page 
 

 

7. Click on the “Next” button in the “Data Range Selection Page”.  This 
activates and displays the 1st “Save Report” page, as illustrated on the next 
page.  Define, if desirable, the file to save, being the report. 
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Figure 10P. 1st Save Report Page 
 

 

8. Click on the “Next” button in the 1st “Save Report” page.  This action 
activates and displays the 2nd “Save Report” page, as illustrated on the next 
page.  This page allows the user to define automatic generation of the report. 
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Figure 10Q. 2nd Save Report Page 
 

 

9. Click on the “Next” button on the 2nd save report page.  This action activates 
and displays the completion page, as illustrated below.  Click the “Finish” button. 

 

Figure 10R. 2nd Save Report Page 
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The report, after completing the wizard, appears, with the appropriate 
information, as defined in the tabs of the “Cost Summary Input” page.  The 
figure, below, illustrates an example a newly generated “Enhanced Cost 
Summary” report. 

 

Figure 10S. Example of an Enhanced Cost Summary Report 
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Chapter 11 — Device-&-Topic Export Utility (Excel Raw Data Utility) 
 

The Device-and-Topic Export Utility - also known as the “Excel Raw Data” Utility 
- provides the user with the ability to export data from the SMS History Database 
to a Microsoft Excel Spreadsheet.  The utility allows a simple, straightforward, 
“raw” export of device or topic information from the SMS History Database to an 
Excel spreadsheet. 

Important!  An Excel spreadsheet has 65,536 rows, which equates to 682 days 
of data.  It also has 256 columns, which equates to 256 devices or topics.  The 
number of sheets is limited by amount of available memory on a PC. 

 

The user exports data from the SMS History Database to a Microsoft Excel file.  
To perform the export, the reader is to read and perform the procedure as 
followed. 

1. Activate and run the SMS client. 

2. Click on the menu item “Reports>Information Manager>Creation 
Wizard”.  This action displays and activates the dialog box, illustrated below. 

 

Figure 11A. Initial Welcome Page 
 

 
 

 

INTRODUCTION 

EXPORTING DEVICE & TOPIC DATA 
USING THE INFORMATION 
MANAGER’S REPORTS WIZARD 
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3. Click on the “Next” button on the “Welcome” page.  This action activates 
and displays the next page, as illustrated below.  This 2nd Welcome page 
contains a list of reports. 

 

Figure 11B. Welcome Page with List of Reports 

 

 4. Select “Add-on Report” in the list of reports in the Welcome page and click 
on the “Next” button.  This action activates and displays the “Add-on Report 
Selection” page, illustrated on the next page. 
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Figure 11C. Add-on Report Selection Page 

 

5. Select “Excel Raw Data” in the list, located in the “Add-on Report Selection” 
page.  Click on the “Next” button in the Add-on Report Selection page.  This 
action displays and activates the “Date Range Selection” page, as illustrated 
below. 

 

Figure 11D. Date Range Selection Page 
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6. In “Date Range Selection” page, select the beginning and ending time range 
to extract data from the SMS History Database.  Refer to appendix B to define 
custom date ranges.  Click on the “Next” button on the “Date Range Selection” 
page.  This action initiates the activation and display of the “System, Device, 
Topic Selection” page, as illustrated below. 

 

Figure 11E. System, Device, Topic Selection Page 

 

7. In the “System, Device, Topic Selection” page, select the desired devices 
and topics from a specified system.  Click on the “Next” button after making 
selections.  This action initiates the display and activation of the “Excel Format 
Selector” page, illustrated on the next page. 
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Figure 11F. Excel Format Selector Page 

 

8. In “Excel Format Selector” page, select “One Sheet per Device” to have 
whole Excel worksheets designated for displaying information for each device, 
with information for individual topics being displayed in separate columns.  Or 
select “One Sheet per Topic” to have whole Excel worksheets designated for 
displaying information for topics, with worksheet columns displaying information 
for specific devices. Click on the “Next” button.  This action displays and 
activates the “Save Report” page, illustrated on the next page. 
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Figure 11G. Save Report Page 
 

 
 

9. In “Save Report” page, enter or select appropriate settings to save a report, 
identifying the nature of the export, and to save the export file.  In the “Save 
Report” page, identify the name of the report and the Microsoft Excel file.  Click 
on the “Next” button on the “Save Report” page.  This action initiates the 
activation and display of the “Schedule Report” page, as illustrated on the next 
page. 
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Figure 11H. Schedule Report Page 
 

 
 

10. Make the necessary selections on the “Schedule Report” page to perform 
automated report runs.  Click on the “Next” button in the page.  This action 
activates and displays the Completion page, as illustrated below. 

 

Figure 11I. Completion Page 
 

 
 

 



 

 
 2007 Schneider Electric, All Rights Reserved  Doc:  3070IB0701 Page 134 

WAGES SMS Add-on Reports & GFX Objects 
Instruction Bulletin 
 

11. Click on the “Next” button on the “Completion” page.  This action displays 
and activates a report, describing the nature of the export.  The figure, below, 
illustrates an example of such a report. 

 

Figure 11J. Example of a Report Describing the Attributes of the 
“Raw” Excel Export 

 

The Excel export file can be accessed in the directory specified in the “Save 
Report” page.  The default directory is the SMS Report directory.  The figures, on 
the next page, illustrate export files, one having worksheets dedicated to 
individual topics and the other having worksheets dedicated to individual 
devices.  The “Open” button activates and displays the MS Excel Export report. 
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Figure 11K. Example of an Excel Export File, Worksheets Focused 
on Topics 

 

Figure 11L. Example of an Excel Export File, Worksheets Focused 
on Devices 
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Chapter 12 — Advanced Summary Export Utility (Excel Advance Summary) 
 

The Advanced Summary Export Utility - also known as the “Excel Advance 
Summary” Utility - provides the user with the ability to export data from the SMS 
History Database to a Microsoft Excel Spreadsheet.  It has two versions.  This 
utility allows for the user to export statistical calculations, such as average, 
maximum value, minimum value, or usage, over a defined period of time. 

 

The utility exports data from the SMS History Database to a Microsoft Excel file.  
To perform the export, the reader is to read and perform the procedure as 
followed. 

1. Activate and run the SMS client. 

2. Click on the menu item “Reports>Information Manager>Creation 
Wizard”.  This action displays and activates the dialog box, illustrated below. 

 

Figure 12A. Initial Welcome Page 
 

 
 

INTRODUCTION 

EXPORTING THE ADVANCED 
SUMMARY REPORT USING THE 
INFORMATION MANAGER’S WIZARD 
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3. Click on the “Next” button on the “Welcome” page.  This action activates 
and displays the next page, as illustrated below.  This 2nd Welcome page 
contains a list of reports. 

 

Figure 12B. Welcome Page with List of Reports 
 

 
 

4. Select “Add-on Report” in the list of reports in the Welcome page and click 
on the “Next” button.  This action activates and displays the “Add-on Report 
Selection” page, illustrated on the next page. 
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Figure 12C. Add-on Report Selection 

 

5. Select “Excel Advanced Summary” in the list, located in the “Add-on 
Report Selection” page.  Click on the “Next” button in the Add-on Report 
Selection page.  This action displays and activates the “Date Range Selection” 
page, as illustrated below. 

 

Figure 12D. Date Range Selection Page 
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6. In “Date Range Selection” page, select the beginning and ending time range 
to extract data from the SMS History Database.  Refer to appendix B to define 
custom date ranges.  Click on the “Next” button on the “Date Range Selection” 
page.  This action initiates the activation and display of the “Device Selection” 
page, as illustrated below. 

 

Figure 12E. Device Selection Page 

 

7. In the “Device Selection” page, select the desired devices and topics from a 
specified system.  Click on the “Next” button after making selections.  This action 
initiates the display and activation of the “Select/Add/Modify Template” page, 
illustrated on the next page. 
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Figure 12F. Example of Select/Add/Modify Template 

 

This page allows a user to use the pre-existing default “BASIC” template, create 
a new template, delete an existing template, or modify an existing template.  At 
set-up, the BASIC template has the following statistical topics. 

• MAXIMUM Demand Real Power 

• MAX DATE Demand Real Power 

• AVERAGE Demand Real Power 

• MINIMUM Demand Real Power 

• MIN DATE Demand Real Power 

• USAGE Real Energy 

The user has the ability to add statistical topics from device topics by selecting 
the device topic in the list on the far-left column of listed devices and clicking the 
right arrow key.  Selecting the device topic in the far-left column of listed 
devices and clicking the right arrow button initiates and displays the “Assign 
Action” dialog box.  The figure, on the next page, illustrates an example of an 
“Assign Action” dialog box. 
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Figure 12G. Example of “Assign Action” Dialog Box, with Statistical 
Topics Selection 

 

In the “Assign Action” dialog box, pull-down the statistical topic selection box and 
select the appropriate statistical topic.  Afterward, press the “USE THIS 
ACTION” button.  This action causes the dialog box to disappear, re-activating 
and re-displaying the “Select/Add/Modify Template” page. The newly selected 
statistical topic for the device topic is in the far right column of listed statistical 
topics. 

The user has the ability to delete statistical topics from a selected template by 
selecting a statistical topic in the far-right column of listed statistical topics and 
clicking the left arrow button. 

The user selects a template by selecting one in the drag-down selection box, 
residing above the far-left column of listed devices and to the left of the “ADD 
NEW” and “DELETE” buttons.  Pressing the “DELETE” button deletes a selected 
template.  Pressing the “ADD” button adds a new template.  Pressing the up 
arrow key moves the selected topics, in the right column, up.  Pressing the 
down arrow key moves the selected topic, in the right column, down.  Topics 
from top to bottom of the list appear from left to right in the Excel spreadsheet 
columns. 

Hitting the “Next” button activates and displays the “Save Report” page.  The 
figure, on the next page, illustrates an example of the “Save Report” page. 
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Figure 12H. Save Report Page 
 

 
 

9. In “Save Report” page, enter or select appropriate settings to save a report, 
identifying the nature of the export, and to save the export file.  In the “Save 
Report” page, identify the name of the report and the Microsoft Excel file.  Click 
on the “Next” button on the “Save Report” page.  This action initiates the 
activation and display of the “Schedule Report” page, as illustrated on the next 
page. 
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Figure 12I. Schedule Report Page 
 

 
 

10. Make the necessary selections on the “Schedule Report” page to perform 
automated report runs.  Click on the “Next” button in the page.  This action 
activates and displays the Completion page, as illustrated below. 

 

Figure 12J. Completion Page 
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The figures, below, illustrate the Advanced Summary Report and the Microsoft 
Excel File with Exported Statistical Topics for Devices. 

 

Figure 12I. Example of an Advanced Summary Report 

 

Figure 12J. Example of a Microsoft Excel File with Exported 
Statistical Topics for Devices 
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Chapter 13 — Navigational Web Page 
 

This chapter describes the navigational web page.  A navigational web page 
resides in the data content of a Web 3000 page, identified in the figure below as 
“Block 4”, “Block 5”, and “Block 6”.  The purpose of a navigational web page is to 
provide navigation to display various GFX diagrams and web browser supported-
media in the main body of the Web 3000 page. 

Note:  this chapter makes the assumption that the user has a thorough 
understanding of constructing GFX diagrams and setting up a Web 3000 page.  
If not, the user may consult the appropriate SMS manuals or consult Power 
Management Organization (PMO) technical support for help at 615-287-3400 or 
e-mail the support group at pmosuprt@squared.com to gain insight into the 
construction of GFX diagrams or setting up a Web 3000 page. 

 

Figure 13A.  Syntactical Diagram of the Navigational Web Page 
 

Note: gray blocks are components common to a web browser and Web 3000 
page.  They are merely in the syntax to help the user to be able to identify the 
actual navigational web components. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(Block 1) Web Page Title Bar 

(Block 2) Web Page Menu Bar 

(Block 3A) SMS Menu Bar Home Page 

SMS Control Bar (Block 3B)Title Bar 

(Block 4) Home 
Page Block 

(Block 5) GFX Diagram with Control Buttons to 
Navigate to GFX Diagrams or Other Web 

Browser Supported-media in Block 6 

(Block 6) GFX Diagram or Any Other Web Browser Supported-media 
(Initiated by Control Buttons in Block 5) 
 
The design of this diagram or web browser supported-output is 
dependent upon the user’s requirements.  The output may represent 
the layout of a facility, institution, factory, or system.  It may have links 
to output that represents sub-systems.  Selection of the links may 
modify the contents of block 5 and block 6. 

home.gfx 
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When developing a Web 3000 page, the user must define a link in a GFX 
diagram page to initiate a navigational web page.  The GFX diagram, to initiate a 
navigational web page, is the initialization diagram.  The user creates the 
initialization diagram.  The initialization diagram requires a single link to the main 
navigational web page.  The user defines the link as follows: 

http://<server_address>/gfxweb/redirect.asp?a=n.gfx&b=main.gfx 

Where <server_address> is the name or IP address of the SMS server. 

 

The user must create two GFX files to compose the main navigational web page.  
They are “n.gfx” and “main.gfx”. 

The file “n.gfx” is the main navigation bar to allow the user to display a 
selection of specific GFX diagrams or web browser supported output pages 
using a series of links.  The file “main.gfx” is the main body of the navigational 
web page and is a GFX diagram that may function as an introduction page or 
overview page.  The two GFX files, “n.gfx” and “main.gfx”, help to compose 
the main navigational web page. 

 

Every navigational web page, including the main navigational web page, consists 
of three frames that hold GFX diagrams or web browser supported-media.  The 
“home page block” diagram is the GFX diagram having a link to the main 
navigation page.  The “navigation” diagram is the GFX diagram that holds the 
series of links to other web navigational pages, GFX diagrams, or other web 
browser supported-media.  The “content” diagram is the GFX diagram or web 
browser supported output page that provides pertinent information relating to 
PowerLogic system components or other miscellaneous information.  In the 
figure on the previous page, “block 4” is the “home page block” diagram, “block 
5” is the “navigation diagram”, and “block 6” is the “content” diagram. 

The links in the “navigation” diagram may contain the following linkage 
command: 

http://<server_address>/gfxweb/redirect.asp?a=<gfx_file_name>&b=<
gfx_file_name> 

Or 

http://<server_address>/gfxweb/redirect.asp?a=<gfx_file_name>&b=<
web_media_name> 

 

<server_address> is the address of the SMS server supporting the navigational 
web pages. 

“redirect.asp” is the application file that initiates the display of a navigational 
web page. 

INITIALIZATION GFX DIAGRAM 

MAIN NAVIGATIONAL WEB PAGE 

SYNTAX OF A NAVIGATIONAL WEB 
PAGE 
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“a=” indicates the first parameter and identifies it as the “navigation” diagram.  It 
is followed by the name of the GFX diagram that acts as the “navigation” 
diagram”. 

“&” delimits the first parameter from the second parameter. 

“b=” indicates the second parameter and identifies it as the “content” diagram.  It 
is followed by the name of the GFX diagram or web browser supported media 
that acts as the “content” diagram. 

 

The navigational web page has a wide degree of flexibility in relation to design.  
As a result, the user should take pre-cautions to create a logical and clean 
construct of navigational web pages.  The user should consider the audience 
viewing the pages and how they might use them. 

Every navigational web page should have the “navigation” diagram with links to 
other navigational web pages.  Every navigational web page should have the 
“content” diagram display a GFX diagram or a web browser supported-media 
page. 

The main navigational web page should be an overview of the subject matter for 
presentation.  All other navigational web pages should be subordinate or 
supportive in subject matter to the main navigational web page.  The following 
bullets provide possible suggestions to navigational web page development. 

• If the user is providing information about a PowerLogic system, then the 
main navigational web page should represent an overview of the system.  
The primary layer of navigational web pages, linked from the main 
navigational page, should be subsystems.  The secondary layer of 
navigational web pages, linked from the primary layers, is a lower functional 
aspect of the system components.  Each navigational web page should 
have links in the “navigation” diagram to go to the parent (navigational web 
page) or to go to children, being either navigational web pages or web 
browser supported-media pages. 

• The main navigational web page could be an index page that refers the user 
to a variety of links.  The links could be links to different navigational web 
pages, GFX diagrams, or other related pieces of information. 

 

 

DESIGN GUIDELINES 
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The following diagram provides an example of a navigational web page. 

 

Figure 13B.  Example of a Navigational Web Page 

 

 

EXAMPLE OF A NAVIGATIONAL 
WEB PAGE 
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Appendix A — Square D Engineered Solutions: Usage Table Manager 
 

The Usage Table Manager, one of the Square D Engineered Solutions, is a tool 
used for classifying input channel data values (or topics) as “usage” topics.  SMS 
needs to know which topics are classified as “(peak) demand” and which topics 
are classified as “usage”.  It relies on the Usage Table Manager to identify which 
topics are “usage”.  Those topics, not classified as “usage”, are classified as 
“(peak) demand” by the SMS.  Without classification of topics as “usage”, the 
report generation component of SMS would not know which topics are “demand” 
and which topics are “usage” when generating a Peak Demand/Usage Report. 

The user activates the “Usage Topic Manager” by clicking on the “Start>All 
Programs>Powerlogic>Addon>Usage Table Manager” menu item on the 
desktop.  This action activates and displays the “Usage Topic Manager” window, 
illustrated in the figure below. 

 

When prompted to enter account and password, enter “master” for account and 
“master” for password. 

 

Figure A1.  Usage Topic Manager Window 
 

 

Clicking on the “Standard” radio button in the “Topics” block invokes the display 
of standard data values (or topics) in the menu box.  Upon clicking the 
“Standard” radio button, the user selects the topic in the menu box and presses 
the “Add Topic to Usage Table” button to classify the data value or topic as 
“usage”. 
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Clicking on the “Custom” radio button in the “Topics” block invokes the display 
of custom data values (or topics) in the menu box.  Upon clicking the “Custom” 
radio button, the user selects the topic in the menu box and presses the “Add 
Topic to Usage Table” button to classify the data value or topic as “usage”. 

The figure below displays a “Usage Topic Manager” with standard topics. 

 

Figure A2.  Usage Topic Manager Window with Topics Not 
Classified as “Usage” – Option to Classify as “Usage” 

 

 

By clicking on the “Usage” radio button, the user may remove topics defined as 
“usage”.  The figure, illustrated on the next page, identifies the “Usage Topic 
Manager” with topics classified as usage.  Upon clicking the “Usage” radio 
button, the user selects the topic and presses the “Remove Topic from Usage 
Table” button to declassify the topic as “usage”. 
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Figure A3.  Usage Topic Manager Window with Topics Classified as 
“Usage” – Option to Declassify as “Usage” 

 

 

This ends this appendix. 
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Appendix B — Square D Engineered Solutions: Period Manager 
 

The Period Manager, one of the Square D Engineered Solutions, is a tool used 
for defining a customized time range from which to access logged input channel 
data values.  The user activates the “Period Manager” by clicking on the 
“Start>All Programs>Powerlogic>Addon>Period Manager” menu item on the 
desktop.  This action activates and displays the “Period Manager” window, 
illustrated in the figure below. 

 

Figure B1.  Period Manager Window 

 

 

By selecting an item in the menu box, the user may edit a customized time range 
by pressing the “Edit” button.  Pressing the “Edit” button invokes the display of 
the “Edit the Period” dialog box, as illustrated in the figure below.  By selecting 
an item in the menu box, the user may delete the customized time range by 
pressing the “Delete” button. 

 

Figure B2.  “Edit the Period” Dialog Box 
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Clicking on the “Add” button invokes the activation and display of the “Add a 
New Period” dialog box.  This dialog box allows the user to add a customized 
date range. 

 

Figure B2.  “Add the Period” Dialog Box 
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